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1. GİRİŞ

CorelDRAW programı, vektör tabanlı bir grafik tasarım programıdır. CorelDRAW illüstratörlerin, tasarımcıların ve profesyonel sanatçıların çalışmalarına yeni boyutlar katacaktır. 

CorelDRAW resim meydana  getirmek için benzersiz yöntemler kullanır. CorelDRAW bit eşlem grafik tasarım paketlerinden farklıdır. Vektör tabanlı bir programdır; yani resimleri matematiksel olarak belirlenmiş vektörler olarak yaratır ve bu şekilde kullanır.  Vektörler, hem büyüklüğü ( boyutu ) hem de yönü ( açı, eğri vb.) olan nesnelerdir. İçinde grafik tabanlı resim saklanan dosyalar listeler halinde yazılmış satırlardan oluşur.  Bu  satırlarda vektörel grafiğin  yeri,yönü uzunluğu, rengi ve eğrisiyle ilgili bilgi bulunur.

Resimleri vektörel tanımlamak,  piksel tanımlamaktan daha etkilidir. Çünkü; piksel tanımlamada bir çizimde binlerce piksel bulunur. Oysa vektor tanımlama da çizimi matematiksel tanımlayarak daha az yer tutmasını sağlayabiliriz. Vektör grafiklerin , piksel tabanlı grafiklerden en önemli avantajı az yer tutmasıdır. Ayrıca Vektör tabanlı grafikler istenildiği kadar büyütülsün çizimde bozulma olmayacaktır. Piksel tabanlı grafikler ise büyütüldüğünde görüntü bozulmaktadır.

Fakat, bazı durumlarda grafik tasarımcılarının piksel tabanlı resimleri tercih etmeleri gerekmektedir. Bu durum, özellikle World Wide Web sitesi için geçerlidir. Bu alanda grafik tasarımlarının pek çoğunun hedefi, web sayfası içinde ya da web sayfası olarak görünen resimlerdir.Tanınmış web tarayıcıları, resimleri CorelDRAW’un kendi biçiminde yorumlayamaz. Web sitelerinde görülen, nisbeten küçük, düşük çözünürlüğe sahip resimler, özgün resim ne kadar yumuşak ya da yüksek çözünürlüklü olursa olsun, eğrilerin köşeli olmasına ve pikselleşmesine yol açar.  CorelDRAW 10’da Corel R.A.V.E programı da bulunur ki , bu programla Flash animasyonları yapılabilir. CorelDRAW 10'u kullanarak ayrıca, herhangi bir nesneyi rollover efektleriyle bir Web düğmesine dönüştürebilir, CorelDRAW'un içindeyken Web'de dolaşılabilir, HTML belge ihraç iş​lemleri hızlı bir şekilde analiz edilebilir ve Web resimleri ihraç edilmeden önce optimize edilebilir. Ayrıca CorelDRAW 10  CorelDRAW , vektör tabanlı bir program olan ve internet dünyasına yeni bir hava getiren Macromedia Flash programı ile bütünleşik bir yapı içindedir. Flash programı için dosyalar üretebilmektedir. Bu özellikleri ile CorelDRAW 10 Web tasarımcılar içinde önemli bir programdır. 

Bu çalışmada , temel düzeyde tasarım yapabilmek için CorelDRAW’ın temel özelliklerine ve genel program yapısına (araç kutuları, iletişim kutuları) değinilmiştir. Anlatımları bol resimlerle görselleştirerek ve bir tasarım çalışmasını detaylı bir şekilde vererek, konunun pekiştirilmesi sağlanmaya çalışılmıştır. 

Birinci bölüm giriş bölümüdür.

İkinci bölümde, CorelDRAW 10’daki yenilikler,

Üçüncü bölümde, CorelDRAW 10 arabirimi ,

Dördüncü bölümde, CorelDRAW 10’ un sayfa yapısını,

Beşinci bölümde, Zoom aracı,

Altıncı bölümde, mönü ve araç çubukları,

Yedi, Sekiz ve Dokuzuncu bölümlerde, nesne çizim, seçilme ve şekillendirme,

Onuncu bölümde, renk paletleri,

Onbir ve onikinci bölümde, nesne düzen ve organizasyon işlemleri,

Onüçüncü bölümde, metin özellikleri,

Ondördüncü bölümde, import ve export filtreleri anlatılmıştır.

Son olarak onbeşinci bölümde ise bir CorelDRAW çalışması detaylı bir şekilde verilmiştir.

2. CORELDRAW 10’DAKİ YENİLİKLER

2.1 Farklılıkları Ekranda Görmek
CorelDRAW 10'un tüm uygulama paketinde kullanılan yeni arabirimi, yeni özelleştirme kontrol​leri, geliştirilmiş çalışma alanı özellikleri ve boyutları değiştirilebilen iletişim kutuları ile karşı​nıza geliyor.
[image: image1.png]# 94,424 mm #¥ 9315 mm
v 138408 m 3 6273 mm.



Simgeler ve Ortak Kullanıcı Arabirimi CorelDRAW 10'u ilk çalıştırdığınızda dikkatinizi en çok çekecek fark, kullanıma yardımcı olarak tasarlanmış ve hemen hemen her seçeneği, efekti ve çoğu komut menüsündeki, Docker penceresindeki ve Araç Çubuğu'ndaki (Toolbar) özellik​leri görsel olarak tanımlayan grafik arabirim simgeleri olacaktır. Bu simgeler CorelDRAW 10, PHOTO-PAINT 10 VE Corel R.A.V.E. tarafından paylaşılan arabirimlerde de ortak olarak kullanıl​makta ve CorelTRACE 10, CorelCAPTURE 10, ve CorelTEXTURE 10 uygulamalarını destekle​mektedir. Şekil 2.1 ‘de  CorelDRAW 10'un uygulama çalıştırıcısı kullanılarak erişilebilen uygulamaları görüyorsunuz.

Şekil 2.1 : CorelDRAW 10 Uygulama Çalıştırıcısı

Windows 2000-Compliant Interface Transparency (Windows 2000 Uyumlu Arabirim Saydamlığı) CorelDRAW 10, Windows 2000 ve Windows XP'nin yeni arabirim özelliklerinin sağladığı avantajlar​dan yararlanmaktadır. Bu özellikler, komut menüleri, araç çubukları (Toolbars), ve Docker penceresi arabirim bileşenlerinden saydam olarak görünmesini istediklerinizi seçebilmenizi sağlar. Bu müthiş yeni özellik sayesinde çizimlerinizi arabirim tarafından engellenmeden göre​bilirsiniz. 
Çalışma Alanı Değiş-Tokuşu Import Workspace ve Export Workspace komutlarından yarar​lanarak CorelDRAW 10 çalışma alanınızı diğer kullanıcılarla (ya da tersi) daha kolay bir şekilde paylaşabilirsiniz. Bu da, artık sadece çizim öğelerinin görünüşlerini değil aynı zamanda bu öğe​lerin diğer kullanıcılar tarafından nasıl oluşturulduklarını ve düzenlendiklerini de kontrol edebi​leceğiniz anlamına gelir, internet erişiminiz varsa, Workspace özellikleri aynı zamanda, Email seçeneğini kullanarak geçerli çalışma alanınızı çalışma arkadaşınıza, müşterinize ya da servis bürosuna elektronik posta yoluyla gönderebilmenizi de sağlar. 
Yenilenen Özelleştirme Kontrolleri CorelDRAW 10'da özelleştirme özellikleri tek sekmeli bir iletişim sayfasında düzenlenerek önemli ölçüde yenilenmiş, böylece daha kolay kullanılır hale getirilmiştir. Artık Options iletişim kutusunun Customization sayfasını kullana​rak menülerin, Araç Kutusunun, araç çubuklarının ve Durum Çubuğunun özelleştirilmesini bir kerede kontrol edebileceksiniz. Araç çubuklarını kolayca oluşturabilecek ve değiştirebilecek, kısayol tuşlarını düzenleyebilecek, ve arabirim bileşenlerinin görünüşlerini kontrol edebilecek​siniz. 
Boyutları Değiştirilebilen İletişim Kutuları CorelDRAW'un önceki sürümlerinde bazı ileti​şim kutularının boyutlarının aşırı büyük oluşu arka plandaki belgenizin neredeyse küçük bir bö​lümünü bile görmenizi engellemekteydi. Şimdi ise pek çok iletişim kutusunun boyutları değiş​tirilebilmektedir. Böylece açık bulunan bir iletişim kutusunu kapatmadan çizim nesnelerinize bakabilirsiniz. 
2.2
Verimlilik ve Performans
Gerçek Zamanlı Önizleme, yeni Undo Docker penceresi, Page Sorterve Navigator View özellik​leri, etkileşimli efektler için ortak hazır efekt kontrolleri, Sürükle-bırak, Import ve Export filtre​lerinin yenilenmiş koleksiyonu, ve önemli ölçüde geliştirilmiş VBA scripting özellikleri ile do​natılan CorelDRAW lO'un daha verimli bir çizim programı olduğunu göreceksiniz.
Gerçek Zamanlı Önizleme CorelDRAW'un yeni Gerçek Zamanlı Önizleme (RealTime Preview) özellikleri önceki sürümlerdeki tipik dış hat önizlemesi yerine nesnelere uygulanan dış hat (outline) ve dolgu (fiil) özelliklerinin her ikisini de belge sayfanızda taşınırken ya da ko​numlandırılırken görebilmenizi sağlar. Gerçek Zamanlı Önizleme aynı zamanda, uygulamadan önce efektlerin uygulama sonuçlarını ve formatlama seçeneklerini görebilmenizi de sağlar. Se​çeneklerle ilgili belirli komutları kullanırken Property Bar seçeneklerini kullanabilirsiniz ve be​lirli özellik değişkenlerini seçtiğinizde efektleri uygulamadan önce ekranda görebilirsiniz. Ger​çek Zamanlı Önizleme özelliğinin etkinliğini Options iletişim kutusunun General sayfasını kul​lanarak istediğiniz zaman kaldırabilirsiniz.
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Undo Docker Penceresi Yeni Undo Docker penceresi, çiziminizin kullandığınız komut sıra​sında belirli bir andaki durumuna geri dönebilmenizi ve çizimin o andaki halini görebilmenizi sağlar. Undo Docker penceresini, belirli işlemleri otomatikleştirmek üzere VBA makro'ları oluş​turmak ve kaydetmek için de kullanabilirsiniz

Şekil 2.2 : Undo Docker Penceresi
Hazır Efektler CorelDRAW 10'un hazır efekt özelliği bütün etkileşimli efektleri içerecek şe​kilde genişletilmiştir ve bu özelliğe Harman (Blend), Kontur (Contour), Çarpıtma (Distortion), Zarf (Envelope), Derinlik (Extrude), ve Gölge (Drop Shadows) efektlerine ait etkileşimli araç​ları kullanırken Property Bar'dan ulaşabilirsiniz. Hazır seçenekler, mevcut hazır efektleri hızlı bir şekilde uygulamanızı veya yeni hazır efektler oluşturup bunları adlandırmanızı sağlarlar.

Yeni I/O Filtreleri İthal ve ihraç işlemlerinde kullanılan Input ve Output filtrelerinin zaten çok geniş olan listesi CorelDRAW'un her yeni sürümüyle daha da genişlemektedir. CorelDRAW bel​genize 50'nin üzerinde farklı dosya formatı ithal edebilir ya da dosya ihraç ederken yaklaşık 40 filtre arasından seçim yapabilirsiniz. Metin, vektör, bitmap ve Web tasarımı, animasyon ya da ofset baskı için dosya hazırlarken kullanılan özel dosya formatlarını olduğu gibi, uygulamalara özgü dosya formatlarını da ithal ya da ihraç edebilirsiniz. 
Süriikle-Bırak Arabiriminizin görünüşünü kontrol edebilmenin yanında, artık arabiriminizi et​kileşimli olarak yeniden düzenleyebilir, birleştirebilir ya da bölümlere ayırabilir, ayrıca, ek​randa sürükle-bırak işlemlerini, iletişim kutularını açmaya gerek kalmadan belirli klavye tuşla​rıyla birlikte kullanabilirsiniz. Araçları, komut düğmelerini, seçenekleri ve seçicileri menüler, araç çubukları ve Araç Kutusu arasında taşıma ve kopyalama imkanı, arabirime büyük esneklik kazandırmıştır. 

Geliştirilmiş VBA Özellikleri Visual Basic for Applications (VBA), CorelDRAW'u kontrol ede​bilmek için makro'lar oluşturmanızı sağlar. Corel firması, CorelDRAW 10'daki VBA programcısı tarafından kullanılabilen komut sayısını önemli ölçüde artırarak CorelDRAW 10'daki gelişmeleri çok daha ileriye götürmüştür. En dikkat çekici ilerlemeler arasında, CorelScript Deprecation, VBA Distribution, Komut çubukları, Nesne Veri ve Özelliklen, Belge Dosya Adı, İhraç, Görüntü, ShapeRange, Eğri ve Düğüm Düzenleme, Metin, Dış hat, Dolgu, Cetvel, Izgara ve Kılavuz Çizgi​leri ve Efektlerle ilgili olanlar sayılabilir.
2.3
Geliştirilmiş Metin Gücü
CorelDRAW 10, tek bir belgede birden fazla dili desteklemekte, metin içeriğini düzenlemek i-çin birleştirilen yazı araçları, yeni metin seçimi ve formatlama özellikleri ve çerçeveler ara​sında metin akışını kontrol edebilmek için yeni komutlar sunmaktadır.
Metin Kutuları İçinde Birden Fazla Dilin Desteklenmesi CorelDRAW 10'daki yeni birden fazla dili destekleme özelliği aynı çerçeveye farklı dillerden metinleri yerleştirebilmenizi sağlar. Ayrıca yazı dili araçlarını değiştirmeye gerek kalmadan birden fazla dilde belge oluşturabilir ve bunları düzeltebilirsiniz. 
Paragraf Seçimi Paragraph Text çerçevelerinde metin düzenlerken, metin imleciyle bir parag​rafı üç kez tıklayarak bütün paragrafı seçebilirsiniz. Üç kez tıklama işleminin son tıklamasında fare düğmesini tutup metin çerçeveniz boyunca yukarı ya da aşağı sürükleyerek önceki ya da sonraki paragrafın tamamını seçebilirsiniz. Metni Paragraph Text çerçevelerinde düzenlerken CTRL ve ALT tuşlarına birlikte basarak çerçevedeki ve bağlı diğer çerçevelerdeki metnin tama​mını seçebilirsiniz. 
Birleştirilmiş Yazı Araçları Yeni ve geliştirilmiş Edit Text (Şekil 2.3), bütün metin düzenlemesini yazım kontrolü ve formatlama işlemlerini tek bir iletişim kutusunda birleştirmektedir. Dış kaynaklar​dan metin dosyalarını doğrudan Edit Text iletişim kutusu düzenleme penceresine aktarabilirsi​niz.
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Şekil 2.3 : Edit Text Kutusu

Yenilenmiş Format Text İletişim Kutusu Metne format uygularken, Format Text iletişim ku​tusunun yapısının, Artistik ve Paragraph Text'in formatlama seçenekleri arasındaki farkı daha iyi yansıtacak şekilde geliştirilmiş olduğunu göreceksiniz. Ayrıca, iletişim kutusu yardımıyla Zoom ve Hand araçlarını kullanarak görüntünüzü büyütüp küçültebilir ve değiştirebilir; iletişim kutusunu kapatmadan Shape aracını kullanarak metne etkileşimli olarak karakter sıkıştırma iş​lemi uygulayabilirsiniz. 
Metin Çerçevelerini Bağlamak/Bağı Çözmek Bağlı Paragraph Text çerçeveleriyle çalışırken, Link ve Unlink komutlarıyla metin akışının yönünü daha iyi kontrol edebilirsiniz. Link ve Unlink komutları iki bağlı Paragraph Text nesnesi seçiliyken Text menüsünde kullanılabilir durumda​dır. Menü komutları ile metin dosyalarını bağlı hale getirmek ve bağı koparmak metin çerçeve​leri arasında metin yerleşimini kontrol ederken Text aracını seçme zorunluluğunu ortadan kal​dırır. 

2.4
Nesne Yönetimi
CorelDRAW'un nesne yönetimi özellikleri içinde ölçekleme işlemleri, yeni seçim kolaylıkları, yeni Micro Nudge özelliği, Distribute geçiş tuşları, otomatik araç pan işlemi, ve geliştirilmiş ız​gara ve kılavuz çizgisi yapışma davranışı sayılabilir. Birden çok nesne seçimlerinde nesne dol​guları ve dış hatları uygularken, geliştirilmiş Outline Pen özellik düzenleme davranışlarını ve doku ve desen dolgusu konularındaki yeni gelişmeleri farkedeceksiniz.
Ölçek Görüntüleme Nesneleri ölçeklerken Property Bar'daki Scale Factor değeri, nesne dö​nüştürme işlemleri esnasında ölçek yüzdesini gösterir. Bundan önceki sürümlerde bu bilgi yal​nızca Status Bar tarafından sağlanıyordu.
Bağlama Duyarlı Select All Komutu Metin sayfanızdaki bütün nesneleri CTRL ve A tuşlarına birlikte basarak hızlı bir şekilde seçebilmenin yanında, artık tüm nesneleri nesne tipine göre de seçebilirsiniz. Bu da bu özelliği bağlama duyarlı hale getirmektedir. Edit -> Select All ko​mutunu seçin ve bir birleşik yol veya bu yolun alt yolları üzerinde Text, Objects, Guidelines, ya da Nodes seçeneklerinden birini işaretleyin.
Yeni Micro Nudge Seçtikten sonra bir nesneyi YUKARI, AŞAĞI, SOL ve SAĞ ok tuşlarına basa​rak varsayılan 0.1 inç'lik aralıklarla hareket ettirebilirsiniz. Bu iteleme (nudging) işlemi esna​sında SH1FT tuşunu basılı tutarak Süper Nudge uygulamak yani nesneyi 0.2 inç'lik (varsayılan) aralıklarla hareket ettirmek de mümkündür. Artık Micro Nudge özelliği yardımıyla, CTRL tu​şunu basılı tutarak nesneleri çok daha küçük aralıklarla da (varsayılan değer = 0.05 inç) hare​ket ettirebilirsiniz. Tipik Nudge varsayılan hareket ettirme aralığı bu sürümde Pick aracını kulla​nırken ve hiçbir nesne seçili değilken Property Bar ile kontrol edilebilmektedir. 
Yapışma Kontrolleri CorelDRAW 10'un nesnelerin ızgara ve kılavuz çizgilerine yaklaşması için daha etkili bir algoritma kullanmasıyla, kılavuz çizgilerine, ızgara çizgilerine ve nesne nok​talarına yapışma özelliği artık daha kolay ve yumuşak bir şekilde gerçekleştirilebiliyor.
Distribute Distribute komutları artık Align and Distribute iletişim kutusunu açmaya gerek kal​madan, Align komutları kadar kolay kullanılabilmektedir. Yeni Distribute tuşları ile, seçilen nesnelerin arasına boşluk koyabilirsiniz. Nesneler geçiş tuşları kullanılarak üst, alt kısımlarına, sol veya sağ taraflarına, sayfaya veya düşey ya da yatay seçim alanlarına göre dağıtılabilirler. 
Herhangi Bir Araçla Auto Panning Automatic Pan ve kaydırma işlemleri artık hangi araç kul​lanılırsa kullanılsın aynı sonucu vermektedir. Örneğin bir dikdörtgen oluştururken tıklayıp sü​rükleyerek dikdörtgeni (genişliğini ya da yüksekliğini tanımlayıp ekran dışına sürükleyerek) gö​rünen ekran alanınızdan daha büyük olacak şekilde çizebilirsiniz. Bunu yaparken, sayfa görün​tüsü sürükleme işleminize uygun olarak kayacaktır.
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Çoklu Seçimlerde Sadece Belirli Outline Pen Özelliklerinin Düzenlenmesi Birden çok nesne seçili durumdaysa ve farklı Outline Pen özellikleri uygulanmışsa Outline Pen iletişim ku​tusunda artık sadece belirli bir özelliği değiştirebilirsiniz. Böylece diğer Outline Pen özellikleri değişikliğe uğramaz. CorelDRAW'un bundan önceki sürümlerinde bu işlem yapıldığında, ileti​şim kutusunda seçilen ayarlar seçimdeki tüm nesnelere uygulanıyordu. Outline Pen özellikleri​nin (örneğin Color, Width ve Style) seçili nesneler arasında farklılık gösterdiği yerlerde seçe​nekler boş olarak görünür (Şekil 2.4). 

Şekil 2.4 : Outline Pen İletişim Kutusu
2.5
Araçlar
CorelDRAW'un bu son sürümünde yeni araçların olmaması tabii ki düşünülemezdi. Artık, glyph düğümlerini kullanan yeni Perfect Shape araçları yardımıyla dinamik olarak şekillendirebilece-ğiniz nesneler oluşturabilirsiniz. Yeni Interactive Contour aracı kullanılarak Kontur efektleri et​kileşimli olarak uygulanabilir. Çarpıtma (Distortion), Zarf (Envelope) ve Gölge (Drop Shadow) efektlerinin yanında vektör ve bitmap derinlik efektlerini uygularken etkileşimli efekt araçla​rındaki küçük gelişmeleri göreceksiniz. PowerClip efektlerine de yeni işlevler kazandırılmış ve Knife ve Eraser araçları ile nesneleri şekillendirme özelikleri geliştirilmiştir.
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Perfect Shape'lerin Oluşturulması CorelDRAW'un araç deposuna yapılan en son eklenti, bir grup Perfect Shape aracından oluşmaktadır (Şekil 2.5). Bu araçlar yardımıyla, dinamik olarak şekillendiril​miş simgeler yaratabilirsiniz. Bu şekillerin (çeşitli stillerde ok, akış şeması şekilleri, yıldızlar ve konuşma balonu şekillerin'çoğu, glyph düğümleri kullanılarak kontrol edilmektedir. Glyph düğümleriyle simge şekillerini ihtiyaçlarınıza cevap verecek şekilde özelleştirebilirsiniz. 
Şekil 2.5 : Perfect Shape Aracı
Geliştirilmiş Knife ve Eraser Aracı Yetenekleri Artık Knife ve Eraser araçlarının her ikisiyle de vektör nesneleri gibi bitmap parçalarını da silebilirsiniz. 
Pick Aracıyla Çerçeve Seçimi Pick Aracı çerçeve seçim tekniklerini kullanarak, kilitli durum​daki nesneleri seçmeden diğer nesneleri seçebilirsiniz. Bu yeni işlev sayesinde sadece kilitli ol​mayan nesneleri kolayca seçebilir, ve böylece çerçeve kullanarak yaptığınız bir nesne seçimin​den sonra kilitli nesnelerden seçimi kaldırma gereğini de ortadan kaldırmış olursunuz.
2.6
Web Özellikleri
Web tasarımcıları, CorelDRAW 10'un en önemli yeni özelliklerinden birinin Web ile ilgili oldu​ğunu duyunca çok sevineceklerdir. Bu elbette sadece Corel R.A.V.E'in eklenmesiyle sınırlı de​ğildir. CorelDRAW 10'u kullanarak ayrıca, herhangi bir nesneyi rollover efektleriyle bir Web düğmesine dönüştürebilir, CorelDRAW'un içindeyken Web'de dolaşabilir, HTML belge ihraç iş​lemlerini hızlı bir şekilde analiz edebilir ve Web resimlerini ihraç etmeden önce optimize ede​bilirsiniz.
Corel R.A.V.E. Açılımı Real Animated Vector Effects (Gerçek Hareketli Vektör Efektleri) olan bu yeni CorelDRAW eklentisi ile, Harman (Blend) ve Kontur (Contour) gibi tanıdık efektleri ya da Tweening (Ara doldurma) işlemini kullanarak kolayca vektör animasyonları yapabilir, bir za​man çizgisi (Timeline) arabirimini kullanarak dönüşüm işlemleri ve nesne gruplarından sahne​ler oluşturabilirsiniz. Animasyonlarda, Web sayfası efektleri ve etkileşimli Web arabirimleri o-luşturmak için kullanılan ve fazla bellek harcamayan dosyalar oluşturan ölçeklenebilir vektör nesne teknolojisi temel alınır. 

Yeni Web Connector Docker Penceresi Yeni Web Connector Docker penceresini kullanarak uygulamanızdan çıkmadan doğrudan CorelDRAW 10'un içinden Internet'te dolaşabilirsiniz. 
Macromedia Flash Desteği Web sayfası tasarımlarında kullanmak ya da doğrudan Macromedia Flash içinde düzenleme yapmak için yeni Macromedia Flash (SWF) filtresini kul​lanarak çizimlerinizi ölçeklenebilir vektör formatında ihraç edebilirsiniz. 
HTML Preflight Yeniden düzenlenen Export to HTML iletişim kutusunun HTML Preflight sek​mesini kullanarak, ihraç ederken belgenizi uyumsuzluk sorunlarına karşı geliştirebilirsiniz. 
Web Image Optimizer CorelDRAW 10'un yeni Web Image Optimizer filtresini kullanarak, Web formatlarında ihraç edildiklerinde resimlerinizin nasıl görüneceğini kontrol edebilir ve gö​rebilirsiniz. Resimlerinizi GIF, JPG, PNG8 ya da PNG24 dosya formatlarında kaydedip hazır se​çenekleri uygulayarak hızlı bir şekilde resimler hazırlayabilir ya da kendi hazır seçeneklerinizi oluşturabilirsiniz [Bölüm 2 : 1,2].

3. CORELDRAW 10 ARABİRİMİ

CorelDRAW’u açtığınızda programı kullanmaya başlarken ilk adımınızı seçmenizi sağlayan kullanışlı bir açılış ekranı görürsünüz. Bu ekran bize bir takım başlama seçenekleri sunar. Bu pencere Şekil 3.1’de gösterilmektedir.
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Şekil 3.1: CorelDRAW 10 Açılış Penceresi

New Graphic  : İçinde tasarım yapabileceğiniz boş bir sayfa açar.

Open Last Edited :  Üzerinde en son çalıştığınız grafik resmini açar.

Open Graphic  : Kaydetmiş olduğunuz grafik resim dosyalarınızdan birini seçmenizi sağlamak için Open Drawing diyalog kutusunu açar.

Template : Başlatacağınız tasarıma temel olarak kullanabileceğiniz, önceden tasarımlanmış sayfa şablonlarının bulunduğu listeden seçim yapmanızı sağlar.

Corel Tutor : Çeşitli çevrimiçi yardım ve yönlendirme sınıfları arasından seçim yapmanızı sağlar.

What’s New : CorelDRAW 10’un yeni özelliklerini sıralar ve açıklar.

Boş yeni bir grafik resmi yaratmak için, New Graphic simgesine tıklanır. Ekranda Şekil 3.2’de gösterildiği gibi boş bir CorelDRAW penceresi görülür.
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Şekil 3.2: CorelDRAW 10  Penceresi

CorelDRAW 10 penceresinin ortasında yer alan araç çubukları haricindeki , çalışma pencersi isimli kısım çizim penceresidir. Çizim penceresi içinde yer alan ve çevresinde gölgeli bir sınır çizgisi bulunan bölüme çizim sayfası denir. Dosya yazıcıya  gönderildiğinde yazılacak olan kısım budur. 

Yazdırmak istemediğimiz ( ama kaydetmek istediğimiz ) grafik resimlerini, çizim sayfasının dışında kalan çizim penceresi alanında saklayabilirsiniz.

4. BELGELERİ VE SAYFALARI KONTROL ETMEK

Bu bölümde, CorelDRAW’un gerekli sayfa ayarlamaları ve kullanıcılara sunduğu sayfa yapıları ile, çok sayfalı dökümanların nasıl oluşturulduğu anlatılacaktır.

4.1 Sayfa Yapısını Ayarlamak

Sayfa yapısı ayarlamak için birkaç yol mevcuttur. Bunlardan en çok kullanılanı, pratik olduğundan dolayı, Property çubuğudur. Pick aracı ile sayfanın boş bir yerine tıklandığında, Proeprty çubuğu Şekil 4.1’de görüldüğü gibi sayfa bilgi ve ayarlarını gösterir. 
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Şekil 4.1 : Property Çubuğu

En solda Size liste kutusu vardır. Burdan istenilen sayfa tipi seçilebilir. Daha sonraki iki kutucuk sayfanın yatay ve dikey boyutlarını belirler. Bunun sağındaki yatay ve dikey iki ikondan oluşan düğmeler ise sayfayı enine ve boyuna olarak yerleştirmeyi sağlıyor. 

4.2 Sayfa Ayarlarında Options Kutusunun Kullanılması

4.2.1 Page / Size İletişim Kutusu

Layout(Page Setup mönüsünden açılan Options iletişim kutusu, Page sekmesi ve Size bölümü aktif olarak açılacaktır. Şekil 4.2’de görülüyor. 
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Şekil 4.2 : Page/Size İletişim Kutusu

Bu iletişim kutusunun içerdiği sayfa seçenekleri şunlardır. 

· Normal Paper / Labels: Normal sayfa, varsayılandır. Label seçildiğinde Options(Label iletişim kutusu açılır.

· Portrait / Landscape: Sayfanın  Width ve Height değerlerini ters çevirir.

· Width / Height: Seçilen kağıt ebadını gösterirler. Custom seçildiğinde, sayfa ebatları manuel olarak girilebilir.

· Bleed: bu seçenek, dökümanlardaki bleed değerini ayarlama imkanı verir. 

· Set From Printer:  Bu seçim, kağıt ebadını, varsayılan yazıcıdaki kağıt ebadı ile aynı ölçüye getirir.

· Save Custom Page: Manuel olarak değer girisi sonucu elde edilen özel sayfaların kaydedilmesini sağlar. 

· Add Page Frame: Sayfaya, yazıcıdaki sayfanın büyüklüğünde bir diktörtgen koyar. Bu dörtgen bir nesnedir. Biçimlendirilebilir ve çıktılarda görünür [1].

4.2.2 Page / Layout İletişim Kutusu

[image: image10.png]


Şekil 4.3’de görülen Page / Layout iletişim kutusunda altı adet yerleşim stili mevcuttur. 

Şekil 4.3 : Page / Layout İletişim Kutusu

· Full Page: Varsayılan stildir. Her kağıda tam sayfa basılır.

· Book: Doküman ikiye bölünecek şekilde her kağıda iki sayfa basılır.

· Booklet:  Doküman dikey olarak ortadan ikiye katlanacak şekilde, her kağıda iki sayfa bsılır.

· Tent Card: Doküman yatay olarak ortadan ikiye katlanacak biçimde her kağıda iki sayfa basılır.

· Side.Fold Card: Doküman, üst kısım için yatay, yan kısım için dikey olarak katlanabilecek biçimde her kağıda dört sayfa basılır

· Top.Fold Card: Doküman, üst kısım için dikey, yan kısım için yatay olacak biçimde, her kağıda dört sayfa basılır [1].

Ayrıca Facing Pages seçeneği, çok sayfalı bir dökümanda, karşı karşıya gelen sayfaları gösteriri. Start On liste kutusu,  çok sayfalı dökümanda, başlangıç sayfasını belirler.

4.2.3 Page / Label İletişim Kutusu
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Bu iletişim penceresi etiketlere özel yapılmıştır. Çünkü etiketler, Property çubuğunda listelenmezler. Şekil 4.4’deki  Page(Label mönüsü ile açılan pencerede, birçok popüler etiket markası listelenir. Sağ bölmedeki pencerede ise seçilen etiketin bir öngörünümü gösterilir. 

Şekil 4.4 : Page / Label İletişim Kutusu

4.2.4 Page / Background İletişim Kutusu

Şekil 4.5’de görülen iletişim kutusunda, sayfa ile ilgili arka plan dolgu seçimi yapılır.  Solid ve bitmap seçenekleri vardır. Solid seçeneğinde normal bir renkle dolgu yapılırken, bitmap seçeneğinde ise, tüm sayfa seçilen bitmaple döşenerek doldurulur.
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Şekil 4.5 : Page / Background İletişim Kutusu

Bitmap Size bölümünde, bitmap resmin boyutları belirlenir. Default Size, onay kutusu işaretlenirse, resim gerçek boyutları ile kullanılır. Custom Size radyo düğmesi işaretlenirse, istenilen yatay ve dikey boyut değerleri girilebilir. Print and Export Background onay kutusu işaretlenirse, sayfa dolgusu, yazı esnasında yazdırılır.

5. GÖRÜNTÜ VE ZOOM

5.1 Zoom Aracı Nasıl Kullanılır

[image: image13.wmf]Bir çizim yapılırken, çizimleri ve nesneleri daha detaylı olarak görmek ve incelemek zorunda kalınan durumlarda zumlama işlemine başvurulur. Şekil 5.1’de araç kutusundan Zoom aracı seçili haldeyken görülmektedir. 

Şekil 5.1 : Zoom Aracı

Zoom aracı basitçe şöyle çalışır. Sol fare tuşuna basılırsa, tıklanan nokta merkez alınarak ekran iki kat yakınlaşır. Sağ  tuş ise tam tersi olan iki kat küçültme işlemi yapar.

[image: image14.wmf]Sağ fare tuşunun davranışı Tools(Options(Workspace(Toolbox(Zoom mönüsünden, Pan tool bölümünde, Şekil 5.2’de gösterildiği gibi değiştirilebilir. 

Şekil 5.2 : Zoom, Hand Tool İletişim Kutusu

5.2 Zoom Araç Çubuğunun Kullanılması

[image: image15.wmf]Zoom araç çubuğunun görnümü Şekil 5.3’deki gibidir. Tüm zoomlama işlemleri buradan yapılır.

Şekil 5.3 : Zoom Araç Çubuğu

5.2.1 Zoom In

Zoom in aracı Zoom aracı ile aynı şekilde çalışır. İmlecin ortasında  + şekli bulunan bir büyütece dönüşür, aynen aracın kendi ikonu gibi. Sol fare tuşu ile ekrana tıklandığında görünüm yüzde 200 büyüyecektir. Bir marque kutusu çizilirse, çizilen kutucuk içinde kalan alan zumlanır. 

5.2.2 Zoom Out

Zoom out aracı seçildiğinde, anında bir önceki zum seviyesine geri dönülür veya daha önce herhangi bir zumlama yapılmadıysa iki katı daha fazla alan gösteren zum elde edilmiş olur. 

5.2.3 Zoom To Selected 

Zoom To Selected aracı öncelikle bir nesne veya nesneler seçmeyi gerektiriyor.  Bir şey seçili olduğunda bu araç zum ayarını değiştirerek seçili olan nesnenin tüm ekranı doldurmasını sağlayacaktır. 

5.2.4 Zoom To All Objects

Bu araç ekranda bulunan tüm nesneler ekranı dolduruncaya kadar dışarı veya içeri doğru zumlama yapar. 

5.2.6 Zoom To Page 

Ekrandaki  sayfanın tüm çizim penceresini dolduracak şekilde zumlanmasını sağlar. 

5.2.7 Zoom To Page Widh

Bu araç, çizimlerin ekran penceresinin enine kadar zumlanmasını sağlar.

5.2.8 Zoom To Page Height

Bu araç çizimlerin ekran penceresinin boyuna kadar zumlanmasını sağlar.

5.3 Standart Araç Çubuğunu Kullanmak

[image: image16.wmf]Standart Araç Çubuğu Şekil 5.4’de görüldüğü gibi zum değerlerini gösteren bir açılır mönüye sahiptir. Ordaki metin kutusuna istenilen değer girilebilir veya açılır listeden bir şık seçilebilir.

Şekil 5.4 : Standart Araç Çubuğu

5.4 Pan İşlemi

Pan işlemi çalışma penceresini hareket ettirerek nesnelerin görünmesini sağlamaktır. Ekran Tüm nesneler görünecek biçimde zum edildiyse gezinmeye gerek duyulmaz. Ancak çok yakın bir zum yapıldıysa diğer nesneleride görebilmek için gezinmek gerekebilir [2].

5.4.1 Pan Aracının Kullanılması

Pan aracı  imleci bir el şekline dönüştürür. Yalnızca el işaretini gitmek istenen yöne doğru kaydırmak gezinmek için yeterli olur [2].

5.4.2 Klavye ile Gezinmek

ALT tuşuna basarak klavye üzerindeki ok tuşlarına basılırsa ekran ok tuşunun yönüne doğru kayar. Bu da bir Pan yöntemidir.

5.5 View Manager

View Manager görünüm tiplerinin saklanabildiği kullanışlı bir alandır. Bu alanda ayrıca zum seviyesi ve sayfa numarası da saklanmaktadır.  Şekil 5.5’de View Manager görülüyor. View Manager’e Window( Dockers( View Manager mönülerinde ulaşılır. 

[image: image17.wmf]Şekil 5.5 : View Manager İletişim Kutusu

Yeni bir görünüm oluşturmak için öncelikle sayfayı seçmek ve kaydetmek istenen büyütme seviyesinde zumlamak gerekiyor.  Daha sonra View Manager mönüsünde bulunan +  işaretine basılarak böylece görünüm ana pencereye eklenir. . işareti ise silinmesini  sağlar.


View Manager penceresinin en solunda bir Page ikonu mevcuttur. Bu görünüm seçildiğinde hangi sayfaya uygulanacağını kontrol ediyor. Sayfa ikonu kapalıysa sadece büyütme görünümü kullanılacaktır. Her sayfdanın sol alt köşesine mutlaka sayfa ikonunun açılması gerekir [2,3].

6. MÖNÜ VE ARAÇ ÇUBUKLARI 

6.1 Mönü Çubuğu

Bir mönü üzerinde fare imleci ile tıklandığında komutla listesinde oluşan bir mönü açılır. Mesela File mönüsü üzerine tıklandığında görünüm kategorisi içerisine giren birkaç ekstar komutla birlikte, ekranın görünümü ile ilgili bir dizi komut karşımıza gelir.

Birçok mönü elemanı kısa yol tuşları ile seçilebilir. Örneğin Transformation Docker penceresini görüntülemek için ALT.A.T kombinasyonlarını kullanmak yeterlidir.

6.2 Pencere Denetim Mönüsü

[image: image18.wmf]Mönü çubuğunun en solunda File mönüsünün hemen yanında bulunuyor ve Corel balonu şeklinde bir  ikona sahip. Pencere denetim mönüsünde temel Windows komutları olan Restore, Move, Size, Minimize, Close ve Next bulunur  (Şekil 6.1).

Şekil 6.1 : Pencere Denetim Mönüsü

6.3 Sağ Fare Tuşu ile Mönülere Ulaşım

Windows 95 veya 98’de ve NT 4.0’ da kullanıcılar ekranda, hemen her yerde sağ tıklayabilirler, muhakkak birşeyler gerçekleşecektir. CorelDRAW 10 da bu özelliği çok fazla kullanıyor. Örneğin ekranda herhangi bir nesne seçili değilken çizim ekranına veya boş bir yere sağ tıklanırsa Document mönüsü açılıyor (Şekil 6.2).

[image: image19.wmf]Şekil 6.2 :  Document Mönüsü

[image: image20.wmf]Bir grup nesnenin üzerine sağ tıklandığında ise Object mönüsü açılır (Şekil 6.3). Bu mönü içerik duyarlıdır. Yani içersinde bulunan maddeler, o anda seçili olan nesnelerin durumuna göre değişir. Bu değişiklikler property (özellikler) çubuğunda anında aktif hale gelir.

Şekil 6.3 : Object Mönüsü

6.4 Toolbar Mönüsü

Toolbar mönüsü, standart araç çubuğu , property çubuğu ya da araç kutusu üzerine sağ tıklanarak açılır (Şekil 6.4). Bu mönü sayesinde ekranda görünecek araç çubukları belirlenir.
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Şekil 6.4 : Toolbar Mönüsü

6.5 Standart Araç Çubuğu

[image: image23.wmf]Şekil 1.3’de gösterildiği gibi, mönü çubuğunun hemen altında yerleşmiş durumda. Bu araç çubuğu üzerinde CorelDRAW’da birçok fonksiyonun yerine getirilmesini sağlayan kısayol düğmeleri bulunuyor. Bu kısayol düğmelerinin yanı sıra Zoom oranını gösteren bir liste kutusu var. Zoom kutusu sayesinde 12 farklı yakınlaştırma tipi buradan seçilebilir: To Selected, To Fit, To Page, To Width, To Height, 10%,25%,50%,75%,100%,200%,400%.

Şekil 6.5 : Standart Araç Çubuğu

Zoom kutusuna herhangi bir rakam girerek de yakınlaştırma işlemini yapabiliriz. Basitçe Zoom yüzdesi kutusu üzerinde tıklanıp ve rakam yazıp Enter tuşuna  basılınca istenen oranda zoom yapılabilir.

Fare imleci, bir kısayol ikonu üzerine getirildiğinde, aracın fonksiyonunu anlatan kısa bir araç ipucu belirir.Seçili olan araç hakkındaki daha detaylı bilgi, ekranın en altında bulunan durum satırında  belirecektir.

[image: image24.png]Saveir | L3 Palettes = ﬁ v

Mk
[RGB

@ Gray100.cpl
@ Grayz2se.cpl
@ userinks.cpl

T

Save as lyper | Customn palette [*.cpl) - Cancel

Dezcription:



Tablo 2.1 : Standart araç çubuğu üzerindeki kısayol ikonlarını ve yaptıkları fonksiyonlar. 
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6.6 Property Çubuğu
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İçerik duyarlı bir komut çubuğudur (Şekil 6.6). Bu çubukta bulunan ayarlar ve seçenekler o anda seçili olan nesnenin veya aracın durumuna göre değişir. Bu çubuğun en önemli faydası, bir çok mönü komutuna veya iletişim kutusuna girmeye gerek bırakmamasıdır. Property kutusunun bu değişken özelliği CorelDRAW’a bir dinamizm katar.

Şekil 6.6 : Property Çubuğu

Bir iletişim kutusu, CorelDRAW’un bir komutu yapabilmesi veya bir işlemi yürütebilmesi için fazladan bilgiye ihtiyaç duyduğu anda kullanıcının lkarşısına getirdiği penceredir. İletişim kutuları sayesinde çalışma ile ilgili gerekli ayarlamalar yapılır.

7. TEMEL NESNE ŞEKİLLERİ OLUŞTURMAK

7.1 Dörtgen çizmek

Dörtgen çizmek için Rectangle aracının seçilmesi gerekir. Bu seçim, araç kutusundan üzerine tıklanarak, F6 tuşuna basarak ya da  çizim alanında sağ tıklanarak açılan mönüden Create Object komutu seçilerek, yine gelen mönüden Rectangle komutu seçilerek yapılır.

Rectangle aracı seçildikten sonra fare imleci küçük bir artı şeklinedönüşür.Dörtgeni çizmek için, dörtgenin başlamasını istenen yere fare ile tıklanır ve diğer istenen köşeye doğru sürüklenir. Dörtgeni çizerken ve çizimden sonra property çubuğu, genişliki yükseklik ve merkez nokta bilgilerini verir. (Şekil 7.1) [4].
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Şekil 7.1 : Genişlik ve Yükseklik Bilgileri
7.2 Elips Çizilmesi

Temel şekillerin arasında ençok kullanılanı elipstir. Her türlü serbest çizimli şeklin oluşturulmasında elipslerin başlangıç noktası olarak kullanılması mümkün. 

Araç kutusundan ellipse aracı ikonu üzerine tıklanır.Fare imlecinin bir elips şekline dönüştüğü görülür. Arac seçidikten sonra, sanal dörtgenin köşesine basılır. Diğer köşeye doğru sürüklenir. Bu esnada oluşan elipsin, genişliği, yükseliği, merkez noktası  hakkındaki bilgileri property çubuğunda görebiliriz. Elipsi  tamamlamak için farenin tuşu serbest bırakılır. Böylece elips çizilmiş olunur.

Elips çiziminde de modify tuşlarından faydalanılabilir. CTRL tuşuna basılı tutmak kusursuz bşr daire elde edilmesini sağlar. SHIFT tuşu ise merkez noktasından başlayarak büyüyen bir elips çizilmesini sağlar. Her iki tuş da basılı tutularak elips çizilirse, merkez noktasından  başlayarak büyüyen bir çemberin çizilmesini sağlar [4,6].

7.3 Çokgen veYıldız Çizmek

Çokgenler CorelDRAW içinde bulunan temel şekillerin en karmaşık olanıdır. Şeklin sahip olması gereken kenarların veya noktaların sayısını belirlenebiliyor, şişkin kenarlar veya noktalar olup olmayacağı tespit edilebiliyor ve  bu noktaların nasıl şekilleneceği ve yerleşeceği belirleniyor. 

Araç kutusundan Polygon aracı üzerine tıklanır. ( object açılır mönüsü içinde bulunur)  imleç bir çokgen şekline dönüşür. Sol fare tuşuna basılı tutularak hayali bir dörtgen çizilirse beş köşeli bir çokgen elde edilir. Default olarak çokgenin köşe sayısı beş olarak belirtilmiştir. (Şekil 7.2) [4,6].
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Şekil 7.2 : Çokken ve Yıldız araç Kutusu

Keskinlik değeri haricinde, diğer çokgen özelliklerini, çizimden önce veya sonra değiştirilebilir. Ancak keskinlik değeri sadece çokgenin çiziminden sonra değiştirilebilir. 

Bir yıldız oluşturmak için property çubuğu üzerindeki polygon/star ikonu üzerine basılarak star seçeneği seçilir. 

7.4 Sarmal Çizmek

Spiral aracı, Object mönüsü içerisinde bulunan üç araçtan ortadakidir. Spiral aracı seçildiğinde imleç bir spiral şekline dönüşür. 

Sarmal çizilmeden önce property çubuğundan gerekli ayarlar yapılabilir. (Şekil 7.3) Sarmalları çizmek de aynen elips çizmeye benzer. Hayali kutuyu bir köşeden diğer köşeye doğru sürüklersek sarmalı çizmiş oluruz. Genişlik ve yükseklik bakımından eşit boyutlarda bir sarmal elde etmek için, çizim esnasında CTRL tuşuna basılı tutulur. SHIFT tuşu basılı tutularak çizim yapılırsa, merkezden başlayarak büyüyen sarmallar çizilebilir.
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Şekil 7.3 : Sarmal Araç Kutusu

Property çubuğunda, çizimden sonra sarım sayısı değiştirilirse, bu değişiklik bundan sonraki çizimler için geçerli olacaktır. Çünkü  sarmallar, çokgenler, elipsler ya da dortgenler gibi dinamik şekiller değildir.

Simetrik sarmallarda, sarmalın her döngüsünde aradaki boşluklar eşit olarak ayarlanır. Logaritmik sarmallarda ise, her sarımda aralardaki boşluklar artırılarak büyür[4]. 

7.5 Grafik Kağıtları Çizmek 

Graph Paper aracı, belirli sayılarda sütun ve satırlardan oluşan ızgaraşar çizilmesini sağlar. Araç çubuğundan bu araç seçildiğinde fare imleci bir ızgara şeklini alır. 
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Izgarayı çizmeden önce property çubuğundan, ızgaranın satır ve sütun sayısının girilmesi gerekir. (Şekil 7.4) Daha sonra aynen dortgendeki gibi çizim yapılır. 

Şekil 7.4 : Grafik Kağıdı Araç Kutusu

Izgara çizildikten sonra sütun ve satır sayısı değiştirilemiyor. Bunun için tüm ızgara silinmeli ve baştan çizilmelidir [4].

7.6 Her şekil ve Boyutta Çizgiler Çizmek

CorelDRAW’da serbest çizimler yapmak için Freehand aracı seçilir. Bu aracın çalışma prensibi iyi anlaşılmazsa verimli çizimler elde edilemez. F5 tuşuna basarak Şekil 7.5’deki araç kutusu ekrana gelir. İstenilen araç seçilerek  aktif hale getirilir.
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Şekil 7.5 : Freehand Araç Kutusu

7.6.1 Freehand Aracı

Bu araç, aynen pencil aracı gibi çalışır. Sürüklendiğinde fare imlecini bir çizgi takip eder. Çizim yapıldıkça, CorelDRAW, çizginin belirli aralıklarına düğüm noktaları yerleştirmeye başlar. Daha az düğüm noktası daha düzgün bir çizim demektir. Fazla düğüm noktasına sahip çizgiler biraz bozuktur. Çünkü her düğüm noktası bir çekim alanı oluşturur. Çizginin, fare hareketlerini ne kadar yakından takip edeceği, property çubuğundaki Freehand Smoothing sürgüsünden belirlenir. 

Bir çizgi çizerken SHIFT tuşuna basılı tutulursa, çizilen bölümler geri alınabilir. SHIFT tuşu bırakıldığında ise çizim işleminde devam edilir. 

Dümdüz çizgiler ise bambaşka bir yoldan elde edilir. Sürüklemek yerine, çizginin başlangıç yerine bir kez tıklanır. Sonra fare ile çizginin sonlanacağı yere de tıklanır. Bu iki nokta arasında dümdüz bir çizgi meydana gelecektir. Yatay ve dikey çizgiler oluşturmak için CTRL tuşuna basılı tutmak yeterli olur. 

Aynı zamanda eğri bir çizgi çizerken düz bir çizgiye geçiş yapılabilir.  Çizgiyi serbest çizim modunda çizerken, düz çizgi elde etmek istenen yerde TAB tuşuna basılır. Düz çizginin sonlanacağı yerde bir kez daha TAB tuşuna basılır [4].

7.6.2
Bézier Aracı

Bézier aracı üzerinde uzmanlaşmak için üzerinde pratik yapmak gerekir.Bu araç bir eğrinin çiziminde ona dilediğimiz şeklin verilmesini sağlıyor. Fare ile tıklandığında yeni bir düğüm noktası oluşturuyor ve bu düğüm noktası ile bir öncekini birleştiriyor. Üzerine gelip tıkladıktan sonra, imleci sürükleyerek, eğriye degişik biçimler verilmesini sağlıyor. 

7.6.3 Artisitic Media Aracı
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Curve açılır penceresinden Artistic Media Aracı seçildiğinde Property çubuğu  Şekil 7.6 da gösterildiği gibi değişecektir. 

Şekil 7.6 : Artistic Media Aracı

İlk beş düğme hangi tipte bir kalem kullanılacağını belirler. Seçenekler arasında, Preset, Brush, Sprayer, Calligraphic ve Presuure bulunuyor. 

Düğmelerin hemen sağında bulunan parametre kutusundan, çizilecek olan şeklin veya çizginin maximum kalınlığı belirleniyor.  

Property çubuğunun en solunda preset mönüsünden bir seçim yapıldığında, imleç bir fırça şeklini alır. Çizim ekranında fareyi tıklayarak sürüklendiğinde seçmiş olduğumuz şekil ile uyumlu bir çizgi elde edilir [4,6].

7.7 Dimension aracı
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Curve açılır mönüsünden Dimension aracı seçildiğinde değişik tiplerde boyutlandırma çizgileri oluşturulabilir. Property çubuğu şekildeki gibi görünür.

Şekil 7.7 : Dimension Araç Kutusu

Kullanıcılar çoğu zaman, boyut çizgilerinin bir başka nesne ile birleşmesini isteyebilir. Bu işlemin aktif hale gelmesi için View mönüsünden Snap To Object komutu seçilir.  Otomatik, dikey, yatay, ve eğimli boyut çizgilerinde bir çizgiyi oluşturmak için üç tıklama gerekiyor. Birincisi, çizginin başlaması istenen yerdir. Daha sonra ölçme işleminin biteceği yer ve son olarak da  ölçüm metninin bulunması istenen yerdir. 

Boyut çizgisi seçildiğinde, boyutun gösteriliş şeklinde birçok değişiklik yapılabilir. Property çubuğu üzerindeki Style açılır mönüsü, Decimal, Fractional, US Engineering ve US Architecture seçeneklerini sunar. Decimal seçeneği, tam sayının ardından nokta işareti konarak ondalık boyut verileceğini bildirir. Noktadan sonra konulacak basamak sayısı ise Precision açılır mönüsünden belirlenir. Fractional seçeneğinde ise  tam sayının ardından kesirli bir ifade belirtilir ve bunun hassasiyeti Precision açılır mönüsünden 1/1024 değerine kadar artırılabilir. US Engineering seçeneğinde, ölçü birimi feet ve inç olarak ve on adet ondalık basamak hassasiyetinde belirtilir.  Hangi birimin seçili olduğunun önemi olmadan US Engineering seçeneğinde birimler her zaman feet ve inç olarak kalır.  US Architecture aynı şekilde inç ve feet olarak birimlendirir. Ancak hassasiyet 1/1024 inç olarak belirlenebilir. 

Birimlerin gösterilmesi istenmiyorsa Show Units bölümü seçilmemiş hale getirilmelidir. Dynamic Dimesioning seçeneği aktif hale getirilirse boyut çizgisinin bir parçası olan boyut metni, boyut çizgisinin boyutu değiştirildiğinde otomatik olarak yeni boyuta göre yenilenecektir. Ölçü biriminin başına ve sonuna, Prefix For Dimension ve Suffix For Dimension kutularını doldurarak, istenilen metinler girilebilir [1,2].

7.8 İnteractive Connector Aracı

Curve mönüsünün en sağında Interactive Connector aracına ait bir ikon bulunur. Bu ikona tıklanark Interactive Connector aracını kullanabilirz. Bu araç yardımıyla, bağlantı çizgileri ile nesneler arasında, nesnelerle nasıl hizalanacaklarıyla ya da şekillerle hangi yolla birleşecekleriyle uğraşmaya gerek kalamadan çizgi çizebilirsiniz. Ayrıca bağlantı çizgileriyle şekillerin konumlarını kendileri bağlayan çizgileri tekrar oluşturmaya gerek kalmadan değiştirebilirsiniz. Bu çizim özelliği ile akış şemaları, bilimsel grafikler, ve sürekli olarak değişiklikler yapmayı gerektiren grafikler oluşturabilirsiniz. 

8. NESNELERİN SEÇİLMESİ

CorelDRAW’da bir nesne ile çalışmaya başlamadan önce, nesne mutlaka seçilmelidir. Neseneleri seçmek için dört temel yol mevcuttur: fareyi kullanmak, marque seçim, TAB tuşu ve mönüleri kullanmak. Eğer yeni bir nesne çizildiyse otomatik olarak seçili hale gelecektir. 

Nesneleri seçmenin en kolay yolu sol fare tuşunu kullanmaktır. Bir nesne seçili olduğunda Property çubuğunda o nesnenin yüksekliği, genişliği, ve merkez noktası gibi oldukça önemli bilgileri gösterilir. Status çubuğu ise  Shape aracı seçili olduğunda kaç tane düğüm noktasının bulunduğunu bildirir. 

Aynı anda birdan fazla nesneyi seçebilmek için SHIFT tuşuna  basılı tutulur ve her nesne tek tek seçilir. 

Bazen bir grup içersinden bir nesneyi seçmek gerekebilir. Bunu yapabilmek için önce grup bozulmalı ve daha sonra istenilen nesne fare ile seçilmelidir. Bundan daha kolay bir yöntem vardır. Nesnenin seçileceği grup seçilir. Ardından CTRL tuşuna basılı tutularak o grup içinden herhangi bir nesne farenin sağ tuşu ile seçilebilir [5,8].

8.1 Digger Aracı

Nesnelerin arkasında kalan, görülmeyen nesnelerin seçilmesinde kullanılır. ALT tuşuna basılı tutularak gizlenmiş nesnenin bulunduğu alana tıklanır. Tıklamaya devam ettikçe nesnenin ortasındaki x işareti ve nesne tutamaçları belirecektir. Bu fonksiyon Digger aracı olarak tabir ediliyor [3].

8.2 Marquee Seçim Yöntemi

Sık sık, birbirlerine komşu olan birçok nesneyi seçme durumlarında bu yöntem tavsiye edilir. Bir Marquee seçimi oluşturmak, seçilecek olan nesnelerin üzerini tamamen kaplayacak biçimde, hayali bir dörtgen çizmek demektir. Tabiki bu hayali dörtgen Pick aracı ile çizilir. 

Marquee seçimi aynı zamanda seçilmişliği ortadan kaldırmak için de kullanılabilir. Seçim esnasında SHIFT tuşuna basılacak olursa hayali dörtgen içinde kalan nesnelere seçilmemiş duruma gelecektir [3].

8.3 Tab Tuşuyla Gezinerek Seçim Yapmak

TAB tuşuna basıldığında diziliş sırasına göre (en son çizdiğimiz şekilden ilk çizdiğimiz şekle doğru) nesnenin seçilmesini sağlar. TAB tuşunu kullanmak, nesnelerin arasında teker teker gezinerek problemli nesneleri veya doldurmaları bulmak için iyi bir yöntemdir. SHIFT TAB kombinasyonu kullanılırsa seçim olayı, diziliş sırasının tersine doğru olur. [3].

8.4 Mönüleri Kullanmak
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Tüm Nesnelerin seçilmesi için Edit→Select All→Objects (CTRL.A) komutu kullanılmalıdır. Diğer bir yol da Pick            aracının üzerine çift tıklamaktır.

8.5 Nesnelerle Çalışmak 

Seçili olan bir nesneyi çizim alanında herhangi bir yere taşımak için sürükleyip taşımak yeterlidir.  Nesne hareket ettiğinde, nesnenin dış hatlarının bir önizlemesi belirerek yeni konumu gösterir. Farenin düğmesi bırakıldığında , hareket tamamlanır.

8.6 Göreceli Yerleştirme

Birçok durumda nesnelerin belirli bir yönde  ve miktarda hareket ettirilmeleri gerekebilir. Bu durumda yerleştirmenin o andaki konuma göre göreceli olması istenir.  Bunun için Arrange→Transformation mönüsünden docker penceresi açılır.  Şekil 8.1’deki ekrana ulaşmak için en soldaki ikona tıklanır. 
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Şekil 8.1 : Arrange / Transformation İletişim Kutusu

Göreceli hareket için istenilen değer girilir. Pencerenin tam ortasında Relative Position onay kutusu bulunmaktadır. Bu kutu işaretlendiğinde H ve V kutularına girdiğiniz değerler, o anda nesnenin bulunduğu konum referans alınarak ve bu konum sayfanın 0.0 koordinatıymış gibi, hareket yapılacaktır [1].

8.7 Nesneleri İtelemek

Nesneleri hareket ettirmenin bir diğer yolu da onları itelemektir. Nesneleri itelemek için klavye  üzerindeki ok tuşları kullanılır. Ok tuşlarına her basıldığında, seçili olan nesne, Tool→Options→Edit iletişim kutusundaki Nudge bölümündeki değer kadar hareket eder.  Bu işlemde; üst, alt, sağ ve sol ok tuşlarına her basıldığında nesne ilgili yönde belirli bir miktar hareket eder. Bu miktarı, Options iletişim kutusunun Rulers sekmesindeki kutulara istediğiniz değerleri girerek belirleyebilirsiniz. Taşıma işlemi yaparken SHIFT tuşuna da basarsak nesne 0.2 inch ilerleyecektir. Eğer CTRL tuşuna basarsak nesne bu kez 0.05 inch ilerleyecektir. 
8.8 Nesneleri Kilitlemek

Bir nesne kilitlendikten sonra hareket ettirilemez, doldurulamaz ve kenar çizgileri değiştirilemez bir hale geliyor.

Bir nesneyi kilitleyebilmek için o nesne seçilir ve sonra da Arrange→Lock Object komutu uygulanır. Bundan sonra kilitli olan bir nesneye herhangi bir müdahele yapmak istendiğinde CorelDRAW sanki hiçbir şey seçili değilmiş gibi davranacaktır.

Bir nesnenin kilidini açmak için önce o nesne seçilir sonra da Arrange→Unlock Object komutu uygulanır [4].

8.9 Nesneleri Boyutlandırmak

CorelDRAW’da bir nesnenin boyutlarını değiştirmenin birçok yolu bulunuyor. En kolay yol Property çubuğu üzerindeki ölçeklendirme kontrollerini kullanmaktır. Buraya nesnenin kesin boyutlarını girmek yerine yüzdelik değerler girerek boyutlandırma yapılabilir. 

8.10 Nesneleri Aynalamak

Tam bir aynalama, nesnenin boyutlarının aynı kalmasını gerektirir. Buna rağmen bazen bu özelliği nesnenin farklı boyutlarda kopyasını oluşturarak gölgelendirme efektlerini oluşturmak için kullanılacaktır. Bu gibi durumlarda efekti fare yardımıyla oluşturabiliriz. Basitçe tutamaçlardan biri tutulur.  Ve aynanın oluşacağı yere doğru nesne sürüklenir. Fare tuşu sonuçtan emin olununca bırakılır.  Bu işlemi yaparken CTRL tuşuna da basılırsa kesin sonuç sağlanır.

8.11 Nesneleri Döndürmek ve Eğriltmek

Bir nesneyi elle döndürmek veya eğmek için seçili olan nesneye ikinci kez tıklanır. Nesne tutamaçlarının Şekil 8.2’deki örnekte olduğu gibi,döndürme tutamacına dönüşür. 
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Şekil 8.2 : Nesne Döndürme Tutamaçları

Nesnenin ortasında raptiye şeklinde görünen ise döndürme merkezidir. Bunu istediğimiz yere taşıyabiliriz. 

Döndürme tutamaçlarından herhangi biri tutulup sürüklendiğinde nesne dönmeye başlar [1,4].

8.12 Transform Araç Çubuğu 
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Property çubuğu üzerinde birçok dönüşüm kutusu vardır. Ama transform araç çubuğu burada yer almıyor. Şekil 8.3’de gösterilen Transform araç çubuğu Property çubuğu üzerindekiler dahil olmak üzere birkaç ekstra araç daha barındırır. 

Şekil 8.3 : Transform Araç Çubuğu

Transform Araç Çubuğuna erişmek için Window→Toolbar mönüsünden Transform onay kutusunu işaretlemek gerekiyor. 

Center Of Rotation metin kutuları bir nesnenin döndürme merkezinin tam olarak belirlenmesini sağlıyor. 

Bu araç  çubuğunun en kullanışlı yeri Apply To Duplicate düğmesidir. Şu anlama geliyor: uygulanmış   olan tüm dönüşümler yeni bir nesne üzerinde gerçekleşecek ve orijinal nesne yerinde sabit kalacaktır. En son düğme olan Relative To Object ise verilen değerlerin  nesneye göre mi yoksa sayfaya göre mi göreceli olduğunu belirler [2].

8.13 Tüm Dönüşümleri Geri Almak

Herhangi bir işlemden vazgeçilip tekrar orijinal nesneyi elde etmek için Edit→Undo  (CTRL Z) komutu uygulanmaktadır. Bir çok işlem yapıldıysa ve bütün dönüşüm işlemleri geri alınmak isteniyorsa Arrange→Clear Transformations komutu uygulanır. Dolayısıyla tüm işlemler bir anda geri alınır ve orijinal nesne tekrar elde edilmiş olur.

9. NESNELERİ ŞEKİLLENDİRME İŞLEMLERİ

9.1 Shape Edit Flyout Mönüsü
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Üzerinde çalışılan nesnelerin görünümünde, çoğu zaman birtakım değişiklikler yapmak kaçınılmaz olmaktadır. Şekil 9.1’de gösterilen Shape Edit Flyout mönüsü dört adet parça içermektedir: Shape, Knife, Eraser ve Free Transform.

Şekil 9.1 : Shape Edit Flyout Araç Kutusu

Belki de en çok kullanılan araç Shape’tir. Eğriler, dörtgenler, çokgenler, yıldızlar, metin, bitmap, zarf ve daha birçoğu üzerinde kullanılır. Her değişik şekil üzerinde biraz daha değişik işlevi olan güçlü bir CorelDRAW aracıdır.

9.2 Düğüm Ne Demektir

Düğümler, bir vektörel çalışmanın yapı taşlarıdır. Düğüm, boşlukta bulunan x ve y koordinatlarına sahip bir noktadan başka bir şey değildir. İlerleyen anlatımlarda düğümlerin nasıl kullanılacağı ve nerelerde ihtiyaç duyulacağı anlatılacaktır.

9.3 Vektör ve Bitmap

CorelDRAW’da oluşturulan tüm nesneler vektör nesnelerdir. Ancak CorelDRAW’da bitmap’ler de kullanılıyor. Bu bitmap’ler de, vektör geometrisi kullanılarak çiziliyor. Her türlü nesne, kalite kaybı olmaksızın dilediğince büyültülebilir ve daha büyük nesneler küçük nesneler ile aynı dosya büyüklüğüne sahip olurlar. Çizilen her şey, matematiksel formüllerle oluşturulur. Bir grafik boyutlandırıldığında bu formuller yeni boyuta göre değişir ve kalite kaybı olmaz. 

Bizim ekranda gördüğümüz her şey, binlerce küçük pikselin birleşiminden oluşur. RGB modeli kullanılıyorsai bu küçük noktaların her biri 16.7 milyon renkten birine sahip olabilir. Dolayısıyla binlerce pikselden oluşan tam renkli bir çizim yapmak için oldukça büyük bir hafızaya ve sabit sabit disk kapasitesine ihtiyaç duyulur. Örneğin masaüstünde bulunan herhangi bir programın ikonunu ele alalım. Oldukça basit gibi görünse de bu küçük ikon bile 1024 noktadan oluşmaktadır. Basılacak olan sanatsal bir çalışmayı bu ikonla kıyaslayacak olursak ne kadar büyük olduğu anlaşılacaktır. Bitmap’lerde tekrar boyutlandırma sırasında, bir çok bilgi eksikliğinden dolayı nesne etrafında bozuklluklar görülecektir.

Bu yüzden herhangi bir çalışma bitmap yerine vektörel olarak tasarlanırsa daha yüksek kalite elde edilir ve sabit disk üzerinde daha az yer kaplar. [4,5].

9.4 Bézier Eğrileri

Fransız matematikçi Pierre Bézier, düzensiz bir eğrinin bir nokta ( x,y ) ve ikikontrol tutamacı x1, y1 ile x2,y2 ile tanımlanacağı fikrini ortaya atmış ve bu bağlamda Bézier  eğrileri oluşturulmuştur. Şekil 9.2’de bir Bézier eğrisi görülmektedir.
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Şekil 9.2 : Bézier Eğrisi

Buradaki sabit nokta CorelDRAW’da düğüm noktası olarak isimlendirilir. İki kontrol tutamacı ise Bézier kontrol tutamaçları olarak isimlendirilir. Bazı düğüm noktalarının üzerinde sadece bir kontrol tutamacı olacaktır. Çünkü bunlar bir düz çizgiyi eğriye birleştirirler. Elde edilen sonuçlarda, iki kontrol tutamacı olursa veya hiçbir kontrol tutamacı olmazsa daha iyi olacaktır. Dolayısı ile diğer kontrol tutamacını oluşturmak için çizgiyi eğriye dönüştürmek gerekecektir [4].

9.5 Düğümlerin Seçilmesi ve Hareket Ettirilmesi

Her düğüm Shape aracı ile üzerine tıklanarak seçilebilir. SHIFT tuşuna basılı tutulursa  birçok düğüm noktası aynı anda seçilebilir veya seçilmiş olanların seçilmişliği kaldırılabilir. Shape aracı ile marque yöntemi de kullanılabilir. Shape aracı ile eğriyi içine alacak biçimde hayali bir dörtgen çizilirse tüm düğüm noktalarının seçili duruma geçtiği görülür. 

9.5.1
Düğümlerin Taşınması

Bir düğüm noktası seçildiğinde, yeni bölgelere sürüklenerek taşınabilir. Eğer birden fazla düğüm noktası seçili ise hep beraber hareket ederler. 

9.5.2
Düğüm Biçimleme Araçları

Düğüm biçimleme araçları iki değişik yerde bulunurlar. Node Pop.Up mönüsü ve Property çubuğu.
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Bir düğüm noktası üzerine Shape aracı ile sağ tıklanırsa Şekil 9.3’de görünen mönü açılacaktır. 

Şekil 9.3 : Düğüm Noktası Özellikleri
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Shape aracı seçili olduğunda Property çubu üzerinde tüm komutları görünecektir (Şekil 9.4).

Şekil 9.4 : Shape Aracı Özellikleri

9.5.3
Düğüm Eklemek ve Silmek

Eğrileri şekillendirirken en uygun şekli elde etmek için bazen, daha fazla düğüm noktasına ihtiyaç duyulur. Bunun için, çizgi üzerinde düğüm noktası olması istenen yere bir kez tıklanır. Daha sonra Property çubuğu üzerindeki  +  işaretine veya klavye üzerinden  +  işaretine basılır. 

Ayrıca bir noktası seçilip sonra da  +  işaretine basılırsa, seçili olna düğüm noktasının bağlı olduğu doğru parçasının tam ortasında yeni bir düğüm noktası belirecektir. Aynı şekilde  − tuşuna basılacak olursa seçilen düğüm noktası silinmiş olur. Var olan düğüm noktasına çift tıklandığında da düğüm noktası silinir [2].

9.5.4
Düğümleri Ayırmak ve Birleştirmek

Herhangi bir düğüm noktası seçilip, Property çubuğu üzerindeki Break Curve ikonuna tıklandığında eğri iki alt yola bölünür. Yani düğüm noktasında itibaren eğri kopartılmış olur. Aynı şekilde, ayrı olan iki düğüm noktasını birleştirmek için, düğümler seçilir ve Property çubuğu üzerindeki Join Two Nodes ikonuna tıklanır [3].

9.5.5
Düğümleri Hizalamak
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Bir ya da daha çok düğüm noktası seçili olduğunda bunları birbirleri ile hizalama seçeneği aktıf hale gelir. Property çubuğu üzerindeki Align Nodes ikonuna tıklanırsa Şekil 9.5’de görülen Node Align iletişim kutusu belirir.

Şekil 9.5 : Node Align İletişim Kutusu

Düğümler yatay veya dikey hizalanabilir. İstenilen seçenek işaretlenir ve OK düğmesine basılır. Hem yatay ve Hem dikey olarak hizalamak için her iki seçenekte işretlenir ve OK tuşuna basılır. Böylece tüm düğüm noktaları üstüste gelir ve garip görünümlü bir eğri elde edilmiş olur [3].

9.6 Gelişmiş Elips Şekillendirme

Elipsleri veya diğer şekilleri kullanarak, yani bunları istenildiği gibi eğip bükerek, büzüştürerek, bir çok enteresan şekil elde edilebilir. Bu çok kullanılan ve güçlü bir yöntemdir. Elipsler dönüştürülmeye başlanmadan önce CTRL.Q tuşlarına basılarak eğrilere dönüştürülmelidir. 

Eğrilere çevrilmiş bir elips elde edildiğinde istenilen şekle dönüşünceye kadar düğüm noktaları çekilir, itilir, Bézier kontrol tutamaçları ile çalışılır ve hatta daha fazla düğüm noktaları eklenerek çalışma güçlendirilir [3].

9.7 Knife Aracı

Knife aracı, Node Edit açılır penceresinde bulunan ikinci araçtır. Knife aracını kullanırken bir düğüm noktasını seçmeye gerek yoktur. Yol üzerinde nereye Knife aracı ile tıklanırsa ordan itibaren kesme işlemi başlayacaktır. Knife ile kesilen nesnelere iki ayrı nesneye ayrılır.. Yani Pick aracı ile taşıyarak bu anlaşılabilir. 

Herhangi bir nesne seçili değilken Knife aracını seçilirse varsayılan değerler değiştirilebilir. Property çubuğunda, düğmeler bulunan nesnenin tek bir nesne olarak kalabilmesini sağlıyor, böylece Knife işleminde sonra yeni nesnelerin oluşması engellenebilir [1].

9.8 Eraser Aracı
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Bu araç, nesnelerin kısımlarının veya bütünlerinin silinmesini sağlar. Shape açılır mönüsünden Eraser aracı seçildiğinde, Property çubuğu Şekil 9.6’de görüldüğü gibi, Eraser aracının özelliklerini gösterir.

Şekil 9.6 : Erase Aracı Özellikleri

Yapılabilecek ilk ayar silginin kalınlığıdır. Diğer ayar ise Auto Reduce On Erase düğmesi ile yapılır. Erase aracı birkaç fazla düğüm noktasının kalmasına sebep olacağından bu düğmenin basılı olması istenebilir. Son olarak da yuvarlak veya kare silgi seçeneği sunan ayar bulunur. 

Seçili bir nesne varsa ve  Eraser aracı aktif haldeyse silme işlemine hemen başlanabilir. Sonuçtan memnun oluncaya kadar silme işleminde devam  edilebilir. 

9.9 Nesne Dışhatlarının Biçimlendirilmesi

Nesneleri çevreleyen çizgilere dışhat denir. CorelDRAW 10’da dışhatlar düzenlenerek çok güzel görünümlü grafikler elde etme imkanı vardır.
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Dış çizgiyi en basit anlamda biçimlemek için Şekil 9.7’de görülen Outline aracı kullanılır.

Şekil 9.7 : Outline aracı

Seçili nesneler için dış hat belirlemenin en hızlı yolu Outline Flyout açılır seçim kutusunu kullanmaktır.burada dış çizgiler için önceden belirlenmiş genişlik değerleri vardır. 2 piksel, 8 piksel, 16 piksel gibi.

Dışhat özelliklerini değiştirmek için Property çubuğu da kullanılabilir. Property çubuğu ihtiyaç duyulan  tüm dışhat özelliklerini sunar (Şekil 9.8).
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Şekil 9.8 : Property Çubuğu Dışhat Özellikleri

Buradaki açılır listeler, ok uçları biçimleri, çizgi stili, çizgi kalınlığı, pozisyon, büyüklük ve boyut ile ilgili seçimler ve ayarlamalar içeriyor. Bu ayarları değiştirmek ve kullanmak çok basttir. Sayfa üzerindeki bir eğri seçildikten sonra, Property çubuğunda yapılan her türlü değişiklik, anında eğriye yansıyacaktır.

Outline Pen penceresi ile de dışhat özellikleri değiştirilebilir. Özel ayarlamalar için kullanılması gereken yer Outline Pen penceresidir. Outline Tool mönüsünün en solunda yer alan Outline Pen Dialog düğmesine basılırsa, Şekil 9.9’da görülen iletişim penceresi açılır. 
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Şekil 9.9 : Outline Pen İletişim Kutusu

İletişim kutusunun üst yarısı, Property çubuğu üzerinde bulunan ayarların aynısını kapsar [1,4].

9.9.1
Edit Style

Yeni çizgiler meydana getirmek için Edit Style düğmesine basıldığında açılan kontrol penceresi kullanılır. Pencerenin üstünde bir sürgü vardır. Bu sürgü yardımıyla  çizgi aralığı ve çizgiyi oluşturacak noktaların seçimi yapılır. Pencerenin altında oluşan yeni çizgi stilinin, bir öngörünümü görülür. Bu ayarlamalardan sonra Add düğmesine basıldığında yeni oluşan çizgi, Property çubuğundaki Outline Style Selecto açılır listesinde otomatik olarak listelenir ve oradan seçilebilir.

Outline Pen  penceresindeki Corner bölümü üç adet köşe şekli seçme imkanı veririr. Bunlar kare, yuvarlak  olabilir.

9.9.2
Line Caps

Bu bölüm üç adet çizgi başlık tipi seçme imkanı sağlar. Çizgi baş ayarı, çizgilerin bitiş yerlerinden itibaren daha ne kadar uzatılacaklarını belirler. 

9.9.3
Behind Fill

Yazı fontlarına dışhat verilmek istendiği zaman, bu onay kutusu işaretlenir. Bu daha iyi bir görünüm sağlar. Çünkü bu onay kutusu işaretlendiğinde önce dışhat çizilir. Bunun üzerine dolgu veya nesneler oturtulur. Bu metot sayesinde, dışhattın dolgu üzerinde kalan yeri, dolgu tarafından kaplanmış olur. 

9.9.4
Scale With Image

Bu onay kutusu işaretli olduğunda (çoğu durumda işaretli olması tavsiye edilir.) dışhat verilen bir nesne boyutlarında değişiklik yapıldığı anda, değişimle doğru orantılı olarak dışhatlarda büyüyüp küçülür. Aksi takdirde kalın dışhatlı bir nesne küçük bir duruma getirildiğinde, bu küçük nesnenin etrafında kaba bir dışhat olacaktır.

9.9.5
Calligraphy

Bu bölüm, çizgilerin dikdörtgen şekillerini ve açılarını değiştiren bir içeriğe sahip.  Stretch ve Angle kutucuklarına girilen değerler ile bu ayarlar değiştirilebilir ve sağ taraftaki kutuda öngörünüm belirir.

9.9.6
Dışhatların Kaldırılması

Outline Tool açılır mönüsünden No Outline düğmesine basılarak, renk paletinden No Fill / No Outline seçeneği seçilerek dışhatlar iptal edilebilir. Ayrıca kapalı olmayan nesnelerdeki dışhatları silmek için Property çubuğundaki Outline Width açılır mönüsündeki None seçeneği seçilir.

9.9.7
Dışhat Çizgilerinin Boyanması

Nesne seçili iken, renk paleti üzerinde herhangi bir renge sağ tıklanacak olursa, dışhatlar anında seçili renk ile doldurulmuş olur. Diğer bir yöntem de Outline açılır mönüsünde Outline Color iletişim kutusunu kullanmaktır. 

9.9.8
Dışhatları Nesne Biçimine Sokmak

Bir dışhattı nesneye çevirmenin avantjı, o dışhattı istenilen biçimde biçimleme imkanı sağlamasıdır. Arrange(Convert Outline To Object komutu uygulanarak, dışhatlar, nesneye dönüştürülür. 

10. RENK PALETLERİ VE DOLGULAR

10.1 CMYK Renk Paleti
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Çizim penceresinin sağ tarafında yerleşmiş olan, varsayılan renk paletinde toplam 100 renk seçeneği bulunur. Varsayılan palet içindeki renkler CMYK renk paletidir (Şekil 10.1). Çünkü CMYK renk modeli, hem ofset baskıda, hemde bilgisayar yazıcılarında hemen her zaman kullanılır. Önemli olan şudur: CMYK process renklerinde baskı yapabilmek için bu paleti kullanma mecburiyeti yoktur. Aslında diğer bütün paletlerden veya renk modellerinden renkler seçilip kullanılabilir ve yine de CMYK renk olarak baskı alınabilir. Bu mümkün çünkü, CorelDRAW baskı motoru spot renkler haricinde geri kalan tümünü CMYK renk olarak algılar. Print iletişim kutusundaki Seperation sayfasından Convert Spot Colors To CMYK kutusu işaretlenirse spot renkler bile CMYK  olarak basılabilir [1,3].

Şekil 10.1 : CMYK Renk Paleti

10.2 RGB Renk Paleti

RGB renk modeli (Şekil 10.2) kırmızı, yeşil ve mavi renkleri içerir. RGB, bilgisayar monitörlerinde kullanılan standart renk modelidir. Her bir renk 0’dan 255’e kadar olan ölçekte hesaplanır. Düşük değerlerin daha açık renkleri gösterdiği CMYK’nın aksine, RGB renk modelinde düşük değerler daha koyu renkleri gösterir. Her üç değerin de 0’a ayarlanmasıyla siyah, yine her üç rengin 255’e ayarlanmasıyla beyaz elde edilir [1,3].
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Şekil 10.2 : RGB Renk Paleti

10.3
Kişisel Paletler Oluşturmak
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Tools→Palette Editor mönüsü kullanılarak kişisel paletler oluşturulabilir. Palette Editör sayfasında New butonuna tıklandığında. Şekil 10.3’de gösterilen iletişim kutusu ekrana gelir. 

Şekil 10.3 : Yeni Palet İletişim Kutusu

Palete bir isim vererek kaydettikten sonra Palette Editor tekrar belirir ve paletimiz listede görülür. Kişisel renklerin barındırılacağı alan şu anda boş bulunmaktadır. 

10.3.1 Kişisel Palete Renkler Eklemek

Palette Editor de Add Color butonuna tıklandığında Select Color iletişim kutusu ekrana gelir. Bu kutu  üzerinde üç adet sekme bulunmaktadır: Models, Mixers ve Palettes.

Kişisel palete renkler eklemek için aşağıdaki adımlar uygulanır. 

1. Palette Editor iletişim kutusundaki Add Color düğmesine basılır. Select color iletişim kutusu ekrana gelir. 

2. Models Sekmesi seçilir.

3. Varsayılan RGB modeli seçili değilse, Models listesindeki ok işaretine tıklanır ve seçilir.

4. Bir renk seçebilmek için, renk gösterim penceresinde herhangi bir yere tıklanır.

5. Add to Palette düğmesine tıklanır. Seçilen renk Palette Editor iletişim kutusundaki yeni palet bölümüne eklenecektir. Her renk seçiminden sonra Add to Palette düğmesine basılarak, renkler kişisel palete eklenmiş olur.

6. Paleti kaydetmeden önce Select Color penceresini kapatmak gerekiyor. Sonra iletişim kutusunun en üstünde bulunan Save düğmesine basın

7. Yeni renklere yeni isimler de verilebilir. Bunun için renk kutusu seçilir ve daha sonra Palette Editor’un en altında bulunan Name kutusu içersine isim yazılır. Son olarak yine Save düğmesine basılır [4,5].

10.4 Açık Dökümanlardan ve Seçili Nesnelerden Paletler Oluşturmak

CorelDRAW da bir resim, şekil veya nesne üzerindeki renklerden paletler oluşturma imkanı vardır. Bunun için aşağıdaki adımları izlemek yeterlidir

1. Hazır bir çizim veya resim doküman içersine aktarılır. 

2. Document→Window→Color Palettes→Create Palette seçeneği seçilir.

3. Save Palette As iletişim kutusu ekrana gelecektir.

4. Palete bir isim vererek kaydedilir. 

10.5 Corel DRAW 10’un Dolgu Tiipleri

CorelDRAW 10, temel tek renkli dolgu tiplerinden sonsuz Texture (doku) çeşitlemelerine kadar uzanan geniş bir seçim imkanı sunar. Her dolgu tipi kendine has özellikler ve seçeneklerle farklı görünümlere sahiptir. Örneğin Uniform dolgular bir tek renkten oluşurken Fountain dolgular kademeli bir renk akışı oluşturmaktadır. Pattern (Desen) dolgular ise birbirini tekrar eden iki ya da daha çok renk ve bitmap desenleri kullanırlar. PostScript dolgular PostScript yazıcı dilinde yazılmış daha karmaşık dokular elde etmenizi sağlayan dolgu tipleridir. Texture ve Mesh tipi dolgularla da , düzenlenebilir düğümlerle kontrol edilen kılavuz çizgileri boyunca akan renk geçişleri oluşturulabilir [1].

10.5.1 Uniform Dolgular
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Uniform dolgu, Uniform Fill iletişim kutusundan uygulanabilir . Bu iletişim kutusu birçok renk modeline ve renk paletine ulaşma imkanı sağlıyor. Bu paletlerden CorelDRAW içersinde oluşturulan nesnelerin içlerini doldurmak için istenilen renkler seçilebiliyor.  Uniform Fill iletişim kutusuna Fill aracı mönüsünden veya Interactive Fill aracı ile bir nesne seçili olduğunda ve Fill Type açılır mönüsünde Uniform Fill kelimeleri belirdiğinde Propery Çubuğu üzerinde Edit düğmesine basılarak ulaşılabilir. Varsayılan Unifor iletişim kutusu Şekil 10.4.’de gösteriliyor.

Şekil 10.4 : Uniform İletişim Kutusu

Varsayılan değer bütün nesneler için No Fill ve metinler için de siyahtır. Varsayılan değerler değiştirilirse aşağıdaki adımlar takip edilerek tekrar yerine konabilir. 

1. Hiçbir nesne seçili değilken Fill aracı üzerindeki No Fill düğmesine tıklanır.
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Burada Uniform Fill mesaj kutusu belirecektir. Graphic onay kutusu (Şekil 10.5) işaretlenir. 

Şekil 10.5 : Uniform Fill Mesaj Kutusu

3. Artistic Text ile Paragraph Text kutuları işaretsiz bırakılır. 

4. OK düğmesine basılır.

5. Fill aracı mönüsünden Fill Color Dialog düğmesine basılır. Bu sefer Graphic Onay ktusundaki işaret kaldırılır Artistic ve Paragraph Text kutularına onay işareti koyulur.

6. OK düğmesine basılır.

7. Şimdi Uniform Fill iletişim kutusu ekrana gelecektir (Şekil 10.5).

8. Color Model düğmesine basılır ve Model açılır mönüsünden CMYK seçilir.

9. C,M ve Y değerlerine sıfır girilir. K kutuusna ise 100 değeri girilir.

10. OK düğmesine basılır [1,3].

10.5.2 Fountain Dolgular
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Fill aracından Fountain dolgular seçilerek ulaşılır. Fountain dolgular bir rengi diğerine doğru harmanlayan dolgu tipidir. Dört değişik tipi bulunuyor. Bunlar, Linear, Radial, Conical ve Square.

Şekil 10.6 : Fountain Fill İletişim Kutusu

10.5.2.1 Linear Dolgular Yapmak

Basit bir doğrusal dolgu aşağıdaki adımlar izlenerek yapılabilir.

1. Sayfaya bir dörtgen çizilir.

2. Interactive fill aracı seçilir.
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İnteractive fill aracını kullanark dörtgenin içine sürükleyin. Şekil 10.7’de görüldüğü gibi bir Linear dolgu oluşturulmuş olur.

Şekil 10.7 : Linear Dolgu Şekli

4. Dolgu üzerindeki doğrusal çizgiyi ve bunun üzerindeki kareleri ve sürgü çubuğunu kaydırarak dolgunun yönünü ve aralıklarını belirleyebiliriz.

5. Sağdaki renk paletinde istenilen renk seçilip dolgu üzerindeki çizgiye sürüklendiği zaman dolguya bir renk daha eklenmiş olur. Bu şekilde istediğimiz kadar renk ekleyebilir ve mükemmel dolgular oluşturabiliriz [2].

10.5.2.2 Dairesel Dolgular Yapmak

Aşağıdaki adımlar uygulanarak basit bir dairesel fountain dolgu oluşturulabilir.

1. Ellipse aracı ile sayfada bir daire çizilir.

2. Interactive Fill aracına tıklanır ve Property çubuğu üzerinden Fountain Fill seçilir

3. Yine Property Çubuğu üzerinde Radial düğmesine basılırsa çizilen daire, bir dairesel dolguyla doldurulmuş olacaktır. 

4. Aynı Linear dolguda olduğu gibi Dairesel dolgu üzerinde de bir çizgi ve renk kareleri bulunur. Bu kareleri ve çizgi üzerindeki sürgüyü sürükleyerek renk aralıkları ve tonlamalar değiştirilebilir. 

5. Oluşturulan Radial (dairesel) Fountain dolgu Şekil 10.8’de görülmektedir [1].
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Şekil 10.8 : Dairesl Dolgu Şekli

10.5.2.3 Conical Dolgular Yapmak

Conical dolgular yapmak için takip edilmesi gereken işlem sırası Radial ve Linear dolgu tipindekilerle aynıdır. Property çubuğu üzerinden Conical seçeneğini seçmek yeterli olacaktır. Dolgu düzenleme işlemleri de aynıdır. Şekil 10.9’de bir conical dolgu ile doldurulmuş bir daire görülmektedir.
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Şekil 10.9 : Conical Dolgu Şekli

10.5.2.4 Square Dolgular Oluşturmak

Yine aynı işlemler yapılır. Property çubuğu üzerinden Square seçeneğini seçmek yeterli olur. Çizim alanındaki doldurulacak olan nesne anında bir Square tipi dolguyla doldurulur. Şekil 10.10’de Square tipi dolgu ile doldurulmuş bir dörtgen görülmektedir.
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Şekil 10.10 : Square Dolgu Şekli

10.5.3 Pattern (Desen) Dolgular
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Pattern dolgulara Fill aracından pattern dolgulara tıklanarak ulaşılır (Şekil 10.11). Üç değişik tipte Pattern dolgu bulunur. Two Color Pattern, Full Color Pattern ve  Bitmap Pattern. [3].

Şekil 10.11 : Pattern Dolgu Mönüsü
10.5.3 1 Two Color Pattern Dolguları 

Çizim ekranı üzerindeki  desen ile doldurulacak nesne seçilir. Daha sonra Property çubuğu üzerinde açılır mönüden Pattern seçilir. Açılır mönünün hemen sağ tarafındaki düğmelerden Two Color düğmesine basılırsa dolguların seçilmesini isteyen bir pencere açılır (Şekil 10.12).
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Şekil 10.12 : Two Color Pattern Araç Kutusu
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Kullanıcı bu pencereden veya Others ikonuna tıklayark başka bir yerden desen seçimini yapar. Tıklama anı aynı anda nesneler seçilen dolgu deseni ile doldurulmuş olur (Şekil 10.13).

Şekil 10.13 : Two Color Pattern Örneği
10.5.3.2 Full Color Pattern Dolguları
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Aynen Two Color Pattern dolgular gibi Interactive Fill aracı ve Property çubuğu kullanarak yapılır. Full Color Pattern dolguları, vektör desenlerdir ve iki renkten çok daha fazlasını kullanırlar. Şekill 10.14’de Full Color Pattern dolgu örneği görülmektedir. 

Şekil 10.14 : Full Color Pattern Örneği
10.5.3.3 Bitmap Pattern Dolguların Kullanılması

Aynen Full.Color Pattern dolgular gibi uygulanırlar. Aşağıda basit bir örnek uygulamanın adımları sıralanmıştır.

1. Sayfaya bir nesne çizilir.

2. Nesne seçili iken Interactive Fill aracıseçilir.

3. Property çubuğu üzerinde bulunan Fill Type liste kutusundan Pattern seçilir.

4. Property çubuğu üzerinden Bitmap Pattern seçilir.
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Bitmap düğmesinin yanındaki  paletten Bitmap dolgusu seçilir. Bitmap desen Şekil 10.15’de görüldüğü gibi olur

Şekil 10.15 : Bitmap Pattern Örneği

10.5.4  Texture (Doku) Dolguları

Doku ( Texture ) dolguları özel bir bitmap türüdür. Seçilebilecek yüzden fazla Texture dolgu bulunmaktadır. 

Interactive Fill aracını kullanarak bir nesneyi Texture Dolgu  ile doldurmak için aşağıdaki adımlar izlenir.

1. Sayfaya bir nesne çizilir.

2. Interactive Fill aracı seçilir ve Property çubuğu üzerindeki Fill Type listesinden Texture Fill seçeneği seçilir.  Nesne varsayılan doku dolgu ile doldurulur. 

3. Texture Library liste kutusundaki aşağı ok üzerine basılır ve Styles kütüphanesi seçilir.
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Texture Library liste kutusunun yanındaki kuıtucuğa tıklanarak Şekil 10.16’da görülen kütüphanedeki dolguların görünmesini sağlanır. 

Şekil 10.16 : Texture Dolgu Araç Kutusu

5. Buradan istenilen bir desen seçilir. 

6. Kare tutamaçlar üzerine tıklanıp sürüklenerek yatay ve dikey olarak esnetilip büzülmesi sağlanabilir. 
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Son olarak dolgu görüntülü nesne Şekil 10.17’deki gibi görünecektir.

Şekil 10.17 : Texture Dolgu Örneği

10.5.5 PostScript Dolgular

Interactive Fill aracını kullanarak PostScript dolgular oluşturmak için aşağıdaki adımlar takip edilir.

1. Doldurulacak nesne seçilir.

2. Interactive Fill aracı seçilir ve Property çubuğu üzerindeki Fill Type liste kutusuna tıklanır. Açılan mönüden PostScript seçeneği işaretlenir. Nesne varsayılan dolgu tipi ile doldurulacaktır. İstenilen dolgu tiplerinin listelendiği kutuyu açmak için Fill Texture liste kutusundaki aşağı ok düğmesine basılı ve istenilen dolgu tipi seçilir.
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Seçimden sonra, nesnenin anında seçilen dolgu ile doldurulduğu görülür. (Şekil 10.18) [2].

Şekil 10.18 : PostScript Dolgu Örneği

10.5.6 Interactive Mesh Dolgu Aracı

Bu araç sayesinde nesneler, interaktif olarak, ekledikçe birbirleri ile harmanlanan renkler ile doldurulabiliyor. Mesh aracına Şekil 10.19’de gösterilen araç kutusundaki Interactive Fill açılır mönüsünden ulaşılıyor. 
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Şekil 10.19 : Interactive Mesh Dolgu Aracı
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Ayrıca bu şekilde Mesh Fill aracı seçili iken Property çubuğu üzerinde seçenekler görülüyor (Şekil 10.20).

Şekil 10.20 : Mesh Fill Aracı

 Bu seçenekler şunlardır.

1. Grid size controls: Yatay ve dikey ızgara çizgilerini artırıp azaltmak için kullanılır.

2. Add intersection: Izgara üzerindeki herhangi bir yere sağ tıklamak Mesh dolgu üzerinde bir gösterge oluşmasını sağlar. Gösterge işareti yerleştiğinde Add Intersection düğmesine basılır. Bu işlem, ızgara üzerinde yatay ve dikey kesişim çizgileri oluşturan yeni kesişim noktaları oluşturur. 

3. Delete Nodes:  Düğüm noktasının silinmesini sağlar.

4. Convert Curve To Line: Düğüm seçili iken bu düğmeye basılırsa eğri düğümler çizgi düğümlere dönüşürler. 

5. Conver Line To Curve: Çizgi düğümleri eğri düğümlere çevirir.

6. Clear Imesh : Mesh dolguyu iptal eder.

10.5.6.1 Interactive Mesh Fill Aracının Kullanılması

1. Dolgu yapılacak nesne seçilir.

2. Nesne seçili iken Fill açılır mönüsünden Mesh aracı seçilir.

3. Renk paletinden istenilen renk seçilir ve düğüm noktalarına veya nesne üzerindeki herhangi bir istenilen yere sürüklenir. Bu işlem istenilen miktarda yinelenebilir.

4. Bu şekilde sanki bir resmi elle boyamış gibi birbirine geçen renkler ve gölgelendirmeler oluşturulabilir. Şekil 10.21’de Mesh dolgu uygulanmış ve şekli değiştirlimiş  bir daire görülmektedir.
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Şekil 10.21 : Interactive Mesh Dolgu Örneği

11. NESNE YÖNETİMİ VE DÜZENİ

11.1 Katman Kavramı

Bir çizimi düzenlerken ve yapılandırırken katmanları (Layers) kullanma şeklinin kendi karakte​rinize ve düşünme tarzınıza bağlıdır. 
Çalışmayı oluşturan tabakalar bir taban üzerinde üstüste sıkıca birbirlerine tut​turulurlar. Yeni tabakalar eklendiğinde ya da mevcut tabakalardan bazıları kaldırıldığında asıl kompozisyon aynı şekilde kalırken, resmin görüntüsü değişir. Yani kullanılan tabakadaki öğe değişmez, resmin görüntüsü hangi tabakanın yerleştirildiğine bağlı olarak değişir.

CorelDRAW'da kullanılan katman kavramı da tamamen olmasa da hemen hemen bu te​mele dayanır. Çizim nesneleriniz belirli katmanlara taşınabilir. Bu özellik aynı zamanda birden çok katman oluşturmanıza, bunları adlandırmanıza ve sayfa yüzeyine göre sıralarını kontrol edebilmenize olanak sağlar. Ayrıca katmanlar içinde nesneleri sıralayabilir, gruplandırabilir ve belirli kaynaklan kullanarak nesne tipleri ya da özellikleri gibi nesne ile ilgili bilgilere erişebilir​siniz. 
CorelDRAW’da çizilen her yeni nesne öncekilerin üzerine konumlanır. Buna diziliş sırası denir. 

Arrange(Order komutu bu diziliş sırasını ayarlamayı sağlar. Nesneller yedi değişik biçimde sıralandırılabilirler.

1. To Front:  Seçili olan nesneyi en üste getirir.

2. To Back: Seçili olan nesneyi en alta getirir. 

3. Forward One: seçili olan nesneyi bir kat yukarı alır.

4. Back One: Seçili olan nesneyi bir kat aşağı alır.

5. In Fron Of: Katmandaki nesne veya nesneleri belirli bir nesnenin önüne yerleştirmek için kullanılır.

6. Behind: Katmandaki nesne veya nesneleri belirli bir nesnenin önüne yerleştirmek için kullanılır.

7. Reverse Order: Seçili olan bir veya daha fazla nesnelerin diziliş sıralarını tersine çevirir [7,8].

11.2 Object Manager
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Katmanlarla ilgili tüm işlemler Object Manager Docker penceresi adındaki bir arabirim bileşeni ile kontrol edilir (Şekil 11.1a). Bu Docker penceresini kullanarak belge sayfaları arasında dola​şabilir, kendi katmanlarınızı oluşturabilir ve bunları adlandırabilir, nesneleri seçip katmanlar arasında taşıyabilir ve katmanların düzenlenebilirle, basılabilme ve/veya görünüp görünmeme durumlarını kontrol edebilirsiniz. Tools -> Object Manager komutunu seçerek Object Manager Docker penceresini açabilirsiniz.

Şekil 11.1 : Object Manager Docker Penceresi
Belgenizdeki her sayfa, her katmanın bazı seçeneklerle birlikte yer aldığı bir katman listesi içerir. Object Manager Docker penceresinde varsayılan olarak Master Page adıyla bir ana sayfa ve bunun altında ızgara (Guides) masaüstü (Desktop) ve ızgara (Grid) nesnelerinizi kont​rol eden katmanlar yer alır.
Çizim penceresindeki nesnelerin görünmesi için Page1 yazısının altındaki + işaretine basmak gerekiyor. 

Pencerenin en üstünde bulunan üç ikon şunlardır. Show Object Properties, Edit Across Layer ve Layer Manager View. Show Object Properties e nesnelerin özelliklerinin görünmesini sağlar.  Edit Across Layer ise seçiliolan katmandaki biçimlendirme yapmayı sağlar veya engeller. Layer Manager View ise nesne görünümünü kapatarak sadece katman bilgilerinin görünmesini sağlar [2].

11.2.1 Object Manager  ile Katmanların Kontrolü

Object Manager  iletişim kutusunun katmanlar bölümü öncelikle Master Page ikonunu gösterir ve daha sonra bu klasör ağaç yapısında değişik kollara ayrılarak şağıdaki ikonları gösterir.

Şekil 11.2’de gösterilen Layers mönüsünü ekrana getirmek için birbiri ile örtüşen dörtgenler ile gösterilen ikona basılır. Bu mönü sayesinde katmanın görünür, basılabilir veya biçimlendirilebilir olması sağlanır.
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Şekil 11.2 : Object Manager Layer Penceresi

Göz ikonları ile dolu ilk sütun, katmanın görünebilir yada görünemez olmasını kontrol eder. İkon karanlık halde ise katman görünmez, tarsine canlı halde ise katman görünür olacaktır.

Sütun ikideki yazıcı ikonu sayesinde katmanların basılabilir ya da basılamaz olmaları belirlenir.

Üçüncü sütundaki kalem ikonları, katmanların kilitlenmesini sağlar. Kilitli bir katmanda biçimlendirme yapılamaz. Kilitin açılması gerekir.

Dördüncü sütunda bulunan ikonlar katmanın rengini temsil eder. Herhangi bir renk üzerine çift tıklanırsa Object Manager iletişim kutusunda o katmana atanan renk değiştirilebilir.

Beşinci sütunda bulunan ikonlar her katmanın ismini gösterir. Ana katmanlar devam edenlerdir. Bu yüzden ana katman üzerine yerleştirilen her nesne,  çok sayfalı bir dökümanda her sayfada görünecektir [2].

12. NESNE ORGANİZASYON İŞLEMLERİ

12.1 Nesneleri Gruplamak ve Çözmek
Belgenizde birden fazla nesneyi seçtiğinizde Group komutu kullanılabilir duruma gelir. Seçili bir nesne topluluğu gruplanmış durumdayken nesnelerin tümü tek bir nesne gibi davra​nır ve çoğunlukla birbirlerine göre konumları sabittir. Seçilmiş bir nesne grubuna uygulanan herhangi bir konum değişimi, dönüşüm ya da diğer özellik değişiklikleri gruptaki her nesneye aynı şekilde etki eder.
Örnek olarak, bir grubu seçerek yeşil dolgu rengi uygularsak, gruptaki tüm nesnelerin dolgu renklerinin yeşile döndüğünü görürüz. Bir resmi oluşturan çeşitli elemanların tümünde, nesne​lerin gruplanabilmesi, birden çok nesnenin tek bir birime indirgenmesini ve böylece çizim elemanlarırıın kolayca en düşük seviyede organize edilebilmesini ve basitleştirilebilmesini sağ​lar.
Bir nesne grubu, aynı zamanda daha düşük seviyedeki grupları da içerebilir. Yani, nesneleri diğer gruplarla bir arada gruplayabilirsiniz. Bu durum bazen yuvalamak (nesting) olarak adlandırılır. Bu basit kavram, nesnelerin düzenlenmesi ve organizasyonu üzerinde mükemmel bir kontrol ve rahatlık sağlar [5,7].
12.1.1 Grup Komutları
İki ya da daha fazla nesneyi gruplamak çok basit bir işlemdir. Bunun için, Pick aracını kullana​rak nesnelerinizi ve ardından Arrange -> Group komutunu seçin ya da CTRL + G kısayolunu kul​lanın. Standart Property Bar'daki (Özellik Çubuğu) Group düğmesini tıklamak da aynı sonucu verir.

Nesnelerin oluşturduğu bir seçimde hangi komutu kullanırsanız kullanın, seçiminiz bir grup oluşturacak ve içindeki nesnelerin tümü tek bir eleman gibi davranacaktır. Seçtiğiniz grup, aynı zamanda Durum çubuğunda da (Status Bar) gösterilecektir. Durum çubuğu eğer Nesne Bilgi​sini (Object Information) göstermeye ayarlandıysa, seçtiğiniz grubun özelliklerinde, içerdiği nesne sayısı görünecektir (bu nesnelerden biri halihazırda bir grup olsa bile). Durum çubuğu, nesne seçimlerinde en iyi bilgi kaynağınızdır.
Birden çok nesneyi gruplama işleminin geri alınması, gruptaki nesnelerin gruplamadan ön​ceki durumlarına dönmelerini sağlayan Ungroup komutunun kullanılmasını gerektirir. Grubu çözmek sadece, nesneler arasındaki grup ilişkisini geri alır, ancak nesneler grubun bir parça-sıyken uygulanan herhangi bir dönüşüm ya da özellik değişimini geri almaz.
Seçili bir nesne grubunu çözmek için, Arrange -> Ungroup komutunu seçin ya da CTRL+U tuşlarına basın. Standart Toolbar üzerindeki Ungroup komut düğmesini tıklamak da aynı so​nucu verir. Ayrıca, seçilen grubu sağ tıklamayla açılan menüden Ungroup komutunu da seçebi​lirsiniz. Ungroup komutu, tek bir nesne grubuyla ya da birden fazla grubu içeren bir seçimle kullanılabilir.
Bir grubu çözmek istiyor ve içinde hala bazı grupların bulunduğundan kuşkulanıyorsanız Ungroup All komutu, seçimdeki tüm grupları tamamen çözmek için kullanılabilir. Ungroup ko​mutu ile Ungroup All komutunu kullanmak arasındaki en belirgin fark, Ungroup komutunun, Group komutunu sadece ilk düzeyde geri almasıdır. Eğer grup içinde yuvalanmış gruplar varsa bunlar korunur. Seçilmiş olan her bir grubu daha ileri düzeyde çözmek için Arrange -> Ungroup (CTRL + U) komutunu ikinci kez kullanın.
Ungroup All komutu, grup içinde yer alan tüm elemanların grup ilişkilerini, bu elemanlar yuvalanmış gruplar olsa da olmasa da iptal eder. Bu, gruplanan nesneler organize bir yapıda dikkatle düzenlenmişse bu düzenin tamamen kaybolacağı anlamına gelir [1,3].
12.2 Nesneleri Kilitlemek ve Kilidi Açmak.
Nesneleri gruplamak, aslında onları birbirlerine kilitler. Eğer isterse​niz, nesneleri Lock komutu yardımıyla bir sayfaya kilitleyebilirsiniz. Nesneler kilitlendiklerinde, görüntülenebilir, izlenebilir, yazıcıda basılabilir ya da seçilebilirler, ancak, hareket ettirilemez ve düzenlenemezler ya da özellikleri hiçbir şekilde değiştirilemez.
Nesneleri kilitlemek, onları geçici ya da kalıcı olarak korumanızı sağlar ve bu, çizim öğele​rinizin yakın çevrelerindeki nesnelere uygulanan komutlardan etkilenmemeleri gereken du​rumlarda yararlıdır. Çiziminizde bulunan kilitli nesne sayısı ya da bir kerede kilitleyebileceğiniz nesne sayısı için bir sınır yoktur.
Nesne gruplama komutlarında olduğu gibi, kilitleme komutları da Lock, Unlock ve Unlock All olmak üzere üç çeşittir. Seçilmiş bir nesneyi kilitlemek için Arrange -> Lock Object ko​mutunu seçin ya da nesneyi sağ tıklayın ve açılan menüden Lock Object komutunu seçin. Bu, nesnenizin kilidi açılmadan düzenlenmesini engeller. CorelDRAW, nesnenin kilitli olduğunu iki şekilde belirtir. Bunlardan birincisi ve en belirgin olanı, nesne seçim tutamaçlarının kilit şek​linde görüntülenmesidir 
İkinci olarak, durum çubuğu, kilitli nesnelerin tanımının başına Locked kelimesini ekler. Örneğin, basit bir eğri kilitliyse ve seçilmişse, durum çubuğunda Locked Curve on LayerX (bu​rada X, katman adını belirtir) adıyla görünür.
Bir nesnenin kilidini açmak için, Arrange -> Unlock Object komutunu seçin. Herhangi bir araçla kilitli bir nesneyi sağ tıkladığınızda açılan menüden Unlock komutunu seçerek de bunu yapabilirsiniz. Bir resimdeki tüm kilitli nesnelerin kilitlerini açmak için Arrange -> Unlock All komutunu kullanabilirsiniz [1,3].
12.3 Nesneleri Klonlamak
Nes​neleri klonlama, çok az kullanıcının yararlandığı güçlü bir özelliktir. Klonlama konusu her ne kadar ilk başta biraz kafa karıştırıcı gözükse de, benzer özelliklerdeki birden çok nesneyi içe​ren resimler oluştururken veriminizi arttıracaktır.
Nesnelerin kopyaları, ikizleri ya da klonları, benzer şekillerde oluşturulmasına rağmen her birinin farklı nesne davranışları vardır. "Klon" adı, "asıl" nesneyle bir ilişkisi olan kopyaları ifa​de eder. Bir nesne klonlandıktan sonra, klon, orijinal nesnede herhangi bir özellik değiştiğinde bunu taklit eder. Klonlama, çizim elemanlarının kopyalarını oluşturabilmenizi ve ayrıca, asıl nesnenin herhangi bir özelliğini değiştirerek ona bağlı olan klonların da aynı özelliklerini bir kerede değiştirebilmenizi sağlar. Bu özellikler, nesnenin konumu, dolgusu, dış hatları, yol şekli, dönüşümler ve Bitmap renk maskesidir [1].
12.3.1 Bir Klon Oluşturmak
Seçili bir nesnenin klonunu oluşturmak için Edit -> Clone komutunu seçin. Orijini nesneniz klonu kontrol eden asıl nesne olacaktır. Oluşturulan klon, belgenizde ilk olarak, Duplicate ko​mutunda kullanılan öteleme değerleri ile aynı değerler kullanılarak konumlandırılır. Klonların nasıl oluşturulduğunu öğrenmek için aşağıdaki adımları takip edin:
1.   Pick aracı ile bir nesneyi tıklayın ve Edit -> Clone komutunu seçin. Bu, nesnenizin bir kopyasını oluşturacak ve öteleme değerlerini kullanarak yerleştirecektir. Klonu, nesne​nin tamamı görünecek şekilde sayfanızda başka bir yere taşıyın.
2.   Orijinal kontrol nesnenizi seçin ve ekrandaki renk paleti yardımıyla dolgu ya da dış hat rengini değiştirin. Klonun renginin de değiştiğine dikkat edin. Asıl nesnenize dönüşüm gibi farklı nesne komutları uygulayın. Bu komutların klonda da tekrarlandığını görecek​siniz.
3.   Asıl nesnenizi ve ardından tekrar Edit -> Clone komutunu seçin. Yeni bir klon oluşturu​lacaktır. Bunu da nesnenin tamamı görünecek şekilde başka bir yere sürükleyin.
4.   Asıl kontrol nesnesini seçin ve bir ya da daha fazla özelliğini değiştirin. Asıl nesneyle birlikte diğer iki klonun da özelliklerinin değiştiğini göreceksiniz [1].
12.4 Nesnelerin Hizalanması

Hizalamak için Align komutu kullanılır. Bu komut  hem Poperty çubuğu üzerinde hem de Arrange(Align and Distribute mönüsü içinde mevcuttur. Align and Distribute kutusu Şekil 12.1’de gösterilmektedir. 
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Şekil 12.1 : Align Mönüsü

Bu pencere Align ve Distribute sekmelerine sahiptir. Hizalama için Align sekmesi kullanılır. Hizalama işlemi için yatay ve dikey konumları belirleyen Left, Center, Right ikonlarından oluşan altı adet onay kutusu vardır. 

İletişim kutusunun en üstünde bulunan ve yatay olarak sıralanmış üç onay kutusu vardır.bunlar nesnelerin dikey olarak hizalanmasını sağlıyor. Sol taraftaki üç adet onay kutusu da yatay  hizalamayı sağlıyor. Edge of page sayfa kenarını baz alıyor. Center of Page onay kutusu, sayfa ortasını baz alıyor. Align To Grid ise gridleri göz önünde bulundurarak hizalama yapıyor.

12.5 Nesneleri Dağıtmak

Distribute komutu, sayfadaki nesneleri belirli boşluklara göre dizmek için kullanılır. Nesnelerin arasında yatay veya dikey olarak belirli mesafede sabit boşluklar olması istiyorsak Distribute komutu kullanılır.

Şekil 12.2’de Align And Distribute sekmeli penceresinin Distribute sekmesi seçili hali görülmektedir.
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Şekil 12.2’de görüldüğü gibi Distribute penceresi, nesnelerin yatay veya dikey olarak dağıtılması için onay kutuları içermektedir. Dört adet yatay, dört adet de dikey dağıtma onay kutusu mevcuttur. Bu dört onay kutusu sırasıyla; nesnelerin sağ taraflarını referans alarak, merkezlerini referans alarak, iç taraflarını referans alarak ve son olarak da sağ taraflarını referans alarak dağıtma işlemi yaparlar [4].

13. METİN ÖZELLİKLERİ

13.1
Artistic Text (Metin)

Artistic Text, kısa metin parçaları oluşturmak ve CorelDRAW ‘ın dönüşüm (Transfornation) ve çarpıtma) (Distortion) özellikleri ile bu metinde değişiklik yapmak için , yazıya özel efekt uygulanmak istendiğinde kullanılır. Artistic Text blokları her paragrafı tek bir satır halinde gösterir. Tüm Artistic Text blokları ayrıdır , metin bloğunun boyu değiştirildiğinde bloktaki metninde boyu değişir.

13.1.2 Artistic Text Oluşturmak
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Bir Artistic Text bloğu oluşturmak için öncelikle araç kutusundan Text aracı seçilmelidir (Şekil 13.1).

Şekil 13.1 : Text Aracının Seçilmesi

Text aracı birkez seçildiğinde, çizim penceresi içersinde herhangi bir yere tıklanır ve yazı yazılamaya başlanır. Varsayılan olarak metin puntosu 24 point ve fontu da Avant Garde Bk BT olarak tanımlanmıştır. 

O anda çaılışılan sayfa üzerinde, doküman için varsayılan punto ve font, herhangi bir metin seçili değilken Property çubuğu üzerinden değiştirilebilir. 

Artistic text herhangi bir grafiksel nesne gibidir. Genişletilebilir, döndürülebilir, uzatılabilir veya bir yol üzerine yerleştirilebilir. Eğer metinlerin şekli doğrudan değiştirilmek isteniyorsa, metnin eğrilere dönüştürülmesi gerekir. Ayrıca Artistic text bloklarında, metnin her satırını birbirinden bağımsız nesne haline getirmek için  Arrange →Break Appart ( CTRL.K ) mönüsü kullanılır [2].

13.2    Paragraph Text ile Çalışmak

Bu yöntem, paragraflar halinde metinler yazmak için kullanılır. Text aracı seçilerek istediğimiz şekilde bir dörtgen çizilirse, Paragraph Text’in yazılacağı alan elde edilmiş olur. Bu alan için istenilen uzunlukta metinler girilebilir ve CorelDRAW  dışında yazılmış olan metinler File→Import mönüsü yardımıyla CorelDRAW içine dahil edilebilir. 

13.3 Artistic Text  ve Paragraph Özellikleri
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Artistic text ve Pargraph Text özellikleri iki  şekilde değiştirilebilir; Property çubuğu ve Format Text iletişim kutusu. Format Text iletişim kutusuna Text mönüsünden Format Text komutu ile ulaşılır. (Şekil  13.2) [2].

Şekil 13.2 : Format Text İletişim Kutusu

13.3.1 Character

Format Text iletişim kutusundaki ilk sekme character sekmesidir. İletişim kutusunun sol tarafında uygun olan tüm fontların bir listesi bulunur. PostScript  Type1 fontları T1 sembolü ile, TrueType fontlar ise TT sembolü ile gösterilirler. Font listesinin en tepesinde ise seçili olan font gösterilir. 

Font kutusunun altında Size( büyüklük ) seçim alanı bulunur. Font büyüklükleri, varsayılan değer olarak Point cinsinden belirtilir. 

Bir sonraki değer ise fontun etkisidir. Style listesinde seçilen font tipine göre değişmekle birlikte, dört değer bulunur. Her font için, görünüm olarak kullanıcıyı yanıltan kelime işlem programlarının aksine, yalnızca uygun olan etkiler gösterilir. Dört muhtemel etki ise Normal, Italic, Bold ve Bold Italic’tir. 

Buradaki son seçenek ise Script’tir. Bu seçeneği kullanarak metin için kullanılan yazı sistemini ayarlayabirlirsiniz. Mevcut seçenekler; Latin, Asian ya da Middle Eastern’dir. Soldan sağa doğru yazı sistemleri için Latin, çift byte karakter kümelerini temel alan düşey yazı sistemleri için Asian, Arapça gibi sağdan sola doğru giden yazı sistemleri için de Middle Eastern kullanılır.

İletişim kutusunun sağ tarafında Underline, Strikethru ,Overline, Uppercase ve Position olmak üzere beş adet açılır mönü bulunuyor. 
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Bunların ilk üçü metin etrafında çizgi oluşturmak için kullanılır ve Single Thin, Single Thick veya Double Thin, olmak üzere seçeneklere sahipler ve tüm etkiler ister tek tek  harflerei isterse tüm kelimelere uygulanabiliyor. Bunlarda her hangi biri seçildiğinde Şekil 13.3’de gösterilen Edit Underline iletişim kutusundan satırların görünümleri biçimlendirilebilir. 

Şekil 13.3 : EditUnderline İletişim Kutusu

Thickness ( kalınlık ) ve Baseline Shift değerleri fontun point biriminin yüzdelik değeri olarak belirtilir, ancak bunlar Units açılır mönüsü kullanılarak değişik birimler şeklinde ayarlanabilir. 

Üç değişik çizgi tipinin altında Uppercase açılır mönüsü bulunur. Metnin büyük harf ayarı yapılır. Varsayılan değer olarak None olarak işaretlenmiştir. Ancak bu, Small Caps veya All Caps olarak değiştirilebilir. Small Caps’te küçük karakterler gerçek büyüklüğünün %80 ‘i oranındaki büyük harflerle değiştirilir. All Caps seçeneğinde ise her karakter birer büyük harf haline dönüştürülür. 

Position listesi ile büyüklüğünü ve düşey konumunu değiştirerek metni bir alt simge (subscript) ya da üstsimge (Superscript) haline getirebilirsiniz. Buradaki seçeneklerden  subscript, metnin boyunu küçültür ve taban çizgisinin altına yerleştirirken, superscript te yine metni küçültür, ancak bu kez büyük harflerin üst kısmının bulunduğu konuma yerleştirir. None seçeneği ise position ayarlarını kaldırır.

13.3.2 Paragraph
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Format Text iletişim kutusundan paragraph sekmesi seçilirse Şekil 13.4’de görünen artistik metin için hizalama seçeneği ve boşluk özellikleri görülür.

Şekil 13.4 :  Paragraph İletişim Kutusu

Varsayılan olarak hhizalama değeri için None seçilmiştir. Left seçilirse her şey sol tarafa hizalanmış olr. Center seçeneği, seçili metinleri tam ortaya yerleştirir. Right seçeneğinde ise tüm metin en sağ sınıra göre hizalanır. Full hizalama seçeneğinde metnin hem sağ hem de sol tarafa hizalanması sağlanır. Force seçeneği, Full hizalamayı bir adım öne götürerek her şeyin hem sağa hem de sola yaslı olmasını sağlar. Dolayısıyla bir kelime varsa bu kelime tüm satıra dağıtılır. 

Spacing ayarları seçilen paragrafın tamamına uygulanır. Tek tek karakterler için değil de paragrafın tümü için geçerli olmak üzere, varsayılan karakter aralığına ne kadar daha boşluk ekleneceği ayarlanır. Sözcük (word) aralığını ayarlamak da mümkündür. Language seçeneği ise; Latin ve Asya veya Arapça karakterleri arasında bırakılacak boşluğu ayarlamada kullanılır.

Paragraf aralığı Before Paragraph ve After Paragraph olarak tanımlanmıştır. Karakter yüksekliği de yüzde veya point cinsinden belirlenebilir. Line sekmesinde ise karakter yüksekliği ile ilgili değerler elle girilebilir.

13.3.3 Tabs

Format Text iletişim kutusunda bulunan ve Şekil 13.5’de gösterilen Tabs sekmesini kullanarak sekme duraklarının konumu üzerinde tam olarak kontrol sağlayabilirsiniz. Üzerinde büyük bir artı işareti bulunana Add Tab düğmesini kullanarak geöerli paragrafa sekmeler ekleyebilir, eksi  düğmesi  ile seçili sekmeyi silebilir, üzerinde kırmızı X işareti bulunana düğme ile de geçerli paragraftaki tüm sekmeleri silebilirsiniz. 
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Bunların dışında, bir sekme durağına yerleştirilen metnin bir öncü karakteri olup olmayacağını belirlenebilir. Öncü karakterler genellikle “İçindekiler” bölümü ve menüler gibi tablo şeklindeki listelerde, sayfanın solundaki başlığı ya da metni sağ taraftaki sayfa ya da fiyatla birleştirmek için kullanılır. Çoğunlukla bir dizi nokta halinde görüntülenir; ancak bunu normal klavye karakterlerinden biriyle değiştirmek mümkündür. Character açılır listesinden bir karakter seçilir, ya da Charecter# kutusuna ilgili karakterlerin numarasını girilerek bu işlem gerçekleştirilir.

13.3.4 Columns
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Şekil 13.6 : Columns İletişim Kutusu

Equal Column Width seçeneği işaretli ise, bir sütunun genişlik değerini değiştirdiğinizde tüm sütunların genişliği aynı değeri alır. Maintain Current Frame Width seçeneği işaretli ise, çerçevenin genişliği değişmeyecektir. 

Vertical Justification listesi kullanılarak metin çerçevenin üstüne, ortasına (düşey olarak) ya da altına hizalanabilir.

13.3.5 Effects

[image: image78.png]


Format Text iletişim kutusunda bulunan son sekme Effects bölümüdür (Şekil 13.7). Madde imleri ve drop cap’lar ler oluşturulmasını sağlar. Varsayılan değerde Effect Type açılır mönüsü None olarak işaretlenmiştir. Ve iletişim kutusu tamamen kapalıdır. Bullet veya Drop Cap seçilirse, sekme kullanılabilir hale gelecektir. 

Şekil 13.7 : Effects İletişim Kutusu


13.4 Madde İmi Efektleri Oluşturmak

Bullet seçeneği işaretlenirsekullanıcının sisteminde kurulu olan fontları gösteren bir pencere açılır.

Bullet, bir paragrafa özel bir etki verilmesini sağlayan bir karakterdir. Normal olarak alfabetik karakter yerine bir sembolle gösterilirler. 

Bir font seçildiğinde, font içersinde bulunan tüm karakterler bu ızgara içinde gösterilir. Buradan bir karakter seçildiğinde bu, paragraf için seçili olan madde imi olur. 

Font açılır mönüsünün hemen altında Size ve Baseline Shift değerleri vardır. Oluşturulan madde iminin büyüklüğü, paragraf metninin büyüklüğü ile aynıdır. Baseline Shift değeri ise madde iminin paragraf satırından ne kadar ağşağıda veya yukarıda yerleşeceğini belirler. Position değeri, madde imi karakterinin sol sınırından ne kadar uzaklıkta olacağını belirler. 

Ayrıca iki adet yerleleşim seçeneği var. Bulleted seçeneği, madde imlerine paragrafın içine doğru yerleştirir ve ikinci satır metnin kalan kısmına değil madde imine göre hizalanır. Hanging Indent, madde imini marjinde asılı bırakarak paragraftaki metnin tüm satırlarda sola hizalı durmasını sağlar. 

13.5 Akan Paragraph Text

Paragraph Text genelde büyük metin blokları için kullanıldığından, çok sık durumlarda bir sayfadan daha fazla veya tek sayfada iki farklı alanda bulunurlar. Bu durumda metin bir çerçeveden bir diğerine akacaktır. Metin, çerçevenin alt tarafından taşarsa, çerçevenin alt orta kısmıdaki tutamacında bir ok işareti belirir. (Şekil 13.8)

Sayfada daha fazla metnin görünmesini istenilen yere gelinir. Bir paragraf çerçevesinin otomatik olarak oluşturulması isteniyorsa yalnızca tıklanır. Otomatik olarak çizilmiş olan çerçeveler sayfa ile aynı ebatta olacaktır. Aynı zamanda istenilen ölçülerde bir paragraf çerçevesi oluşturmak için tıklamadan sonra sürüklenmesi yeterli olur. Çerçeveler birbirlerine bağlandıklarında, bunların bağlı olduklarını gösteren bir çizgi aralarında belirecektir. Bu çizgi yalnızca bilgi amaçlıdır ve baskı esnasında görünmez. Şekil 13.8’de iki  çerçeve arasında akan metin örneği görülmektedir [2].
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Şekil 13.8 : Akan Paragraph Text

13.6 Artistic ve Paragraph Text  Arasında Dönüşüm

Başlarken yanlış tipte bir metin oluşturulduğunda, diğer tipe dönüştürmek için Text mönüsü altındaki Conver komutu kullanılır.

Paragraph Text seçili ise ve metnin tamamı tek bir çerçeve içerisinde gösterilemiyorsa Convert komutu kararmış olarak görünür. 

13.7 Küçük-Büyük Harf Dönüşümü
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Metinlerde harflerin büyük veya küçük olması değiştirilebilir. Bunu için Text mönüsü altındaki Change Case komutu kullanılır. Bu komut seçildiğinde Şekil 13.9‘da görülen Change Case penceresi açılır. 

Şekil 13.9 : Change Case Penceresi

Burada beş seçenek sunulur. Sentence cas seçeneği her cümlede ilk harfi büyük yapacaktır. Lower case seçeneği ise tüm harfleri küçültür. UPPERCASE seçeneği ise tüm harfleri büyültür. Title Case seçeneği her kelimenin ilk harfini büyültecektir. Ayrıca tOOGLE cASE seçeneği büyük harfleri küçük, küçük harfleri büyük hale getirir. 

13.8 Semboller

Semboller, Symbols Docker içinde bulunurlar. Şekil 13.10’da gösterilen Docker penceresini açmak için window→Dockers→Symbols mönüsünden Special Characters  ( CTRL.F11) seçeneği seçilir. 

[image: image81.wmf]Şekil 13.10 : Sebmol Docker Penceresi

Pencereninen üstünde, sembol olarak kullanılabilecek olan fontların listesi bulunur. Normalde bunlar, Windows’a kendilerini sembol grubu olarak tanıtan fontlardır. Dolayısıyla CorelDRAW’da herhangi bir değişiklik yapmaya gerek kalmadan, yalnızca sembol içeren fontların alfabetik listesi görülür. Bunu değiştirmek içinse font listesinin yanında bulunan ok işaretine basarak pencerenin açılması sağlanır ve TrueType veya Type1 fontların görüntülenmesi sağlanır. 

Font listesinin hemen altında, seçilen sembol fontunun grafiksel karakterleri bulunur. Pencerenin sağındaki bir kaydırma çubuğu istenilen karakteri bulana kadar pencereyi kaydırmayı sağlar. 

İstenilen sembol seçildikten sonra bunu çizim penceresine sürüklemek yeterli olur. Başlangıçta tek bir sembol elde edilebilir. Ancak  Tile Symbol/Special Character mönüsünden sembolün tüm sayfaya döşenmesi sağlanabilir.
14. IMPORT VE EXPORT FİLTRELERİ

14.1
Filtreler Nasıl Çalışır
Filtreleri başka uygulamalarda oluşturulan dosyalar için çeviriciler olarak düşünün. Inıporl (it​hal) Filtreleri veriyi diğer uygulamalardan alır ve CorelDRAW içinde görüntülenebilecek ve dü​zenlenebilecek şekilde çevirir. Dosyanın tipine bağlı olarak çoğunlukla elinizde ithal işleminin ince ayarlamalarını yapabileceğiniz ek seçenekler bulunur ve böylece işinizi en verimli şekilde devam ettirebilmeniz için verileri CorelDRAW'a tam olarak ihtiyacınız olan şekilde aktarabilir​siniz.
Export (İhraç) Filtreleri, veriyi CorelDRAW belgenizden alır ve diğer programın ya da yayın aracının "dilini konuşabilecek" hale dönüştürürler. Import filtrelerinde olduğu gibi, Export filt​releri de diğer uygulama ya da yayın aracının tam olarak ihtiyaç duyduğu veriyi hassas olarak aktarmak için gerekli olan iletişim kutularına sahiptirler [5].
14.2
Bir Dosyayı İthal Etmek
İthal işlemi, File menusunu tıklayıp Import komutunu seçerek ya da CTRL + I tuşlarına basarak yapılabilir. Bu, ana Import iletişim kutusunu açar. İthal etmek istediğiniz dosyanın sürücü, yol adı ve dosya adını yazabilirsiniz. Eğer doğru sürücü ve klasördeyseniz sadece dosya adını ya​zın. Ayrıca File Type açılan liste kutusunu tıklayıp aradığınız dosyanın uzantısını (örnek olarak Adobe Photoshop için PSD, Corel PHOTO-PAINT için CPT) seçerek dosyanızı arayabilirsiniz. Import iletişim kutusunda çeşitli seçenekler bulunmaktadır (Şekil 14.1).
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Şekil 14.1 : Import İletişim Kutusu

•    Link Bitmap Externally seçeneği, bitmap'i ithal ettiğiniz dosyaya bağlamak için (bitmap'i dosyanızın bir parçası olarak dahil etmek yerine) kullanılır. Bağlanmış bir bitmap içeren bir CDR dosyasını kaydettiğinizde dosya boyutu küçük olacaktır, çünkü bitmap ayrı olarak saklanmaktadır. CorelDRAW dosyanızı kapattıktan sonra bile bağlan​mış bitmap'lerinize ulaşabilir ve bunları Corel PHOTO-PAINT, Adobe Photoshop ve diğer bitmap düzenleme programlarında düzenleyebilirsiniz.
• Combine Multilayer Bitmap seçeneği, birden çok katman içeren bitmap'leri CorelDRAW içinde tek bir düzleştirilmiş (birleştirilmiş) katman olarak açmanızı sağlar.
•    Dosyaları ithal ederken, gömülmüş olan ICC profillerini çıkarıp sabit diske kaydetmek için Extract Embedded ICC Profile seçeneğini kullanabilirsiniz.
•  Check For Watermark seçeneği dosyayı kontrol ederek şifrelenmiş bir DigiMarc watermark kodu içerip içermediğini görmek için kullanılır. DigiMarc, resimleri sayısal olarak "imzalamak" ve bu resimlerin, bunları oluşturan kişilere ait olduklarını belirtmek için kullanılır (Not: DigiMarc, özellikle GIF ve JPG gibi yüksek sıkıştırmalı formatlarda %100 verimli değildir.)
•    Do Not Show Filler Dialog seçeneği, dosyayı varsayılan ayarları kullanarak ithal etme​nizi sağlar. Çoğu kez, varsayılan ayarların tercih ettiğiniz ayarlar olduğunda; -min oldu​ğunuz durumlar hariç, bu seçeneği işaretlemeden bırakmak isteyeceksiniz.
•    Maintain Layers And Pages seçeneği, katmanlar ve/veya sayfalar kullanılarak kaydedil​miş dosyalan (Adobe Acrobat dosyalan gibi) ithal ederken, dosyanın orijinal katman ve/veya sayfa yapısını korumak için kullanılır.
•    İletişim kutusunun alt tarafında, Link To High Resolution File For Output Using OPI seçeneğini göreceksiniz. Bu, TIFF bitmap'ler ve SCITEX CT bitmap'lerle çalışırken kul​lanılabilir. Bu seçenek, dosyanız ekranda görüntülenirken, yüksek çözünürlüklü resim​leri düşük çözünürlüklü yer tutucularla değiştirir. Yüksek çözünürlüklü resimler korunur ve baskı sırasında kullanılır (Buna FPO - For Printing Only (Sadece Baskı İçin) de de​nir). TIFF ve CT (özellikle CT) resimleri bazen inanılmaz derecede büyük olabildiği için, bu seçenek belgenin diğer öğeleriyle (metin gibi) çalışırken sistem kaynaklarının TIFF ya da CT dosyası için harcanmasını önler.
•   Yine iletişim kutusunun sağ tarafında, resmi açmadan önizlemek için kullanılan bir se​çenek bulunur. Onizleme resimleri kaydedilmemiş büyük resimleri önizlerken, hesap​lama için biraz zaman gerekeceğini unutmayın.
•  İletişim kutusunun sağ tarafında ayrıca, bütün (full), kırpılmış (cropped) ya da yeniden örneklenmiş (resampled) bir resmi ithal etmek için kullanılan bir seçenek bulunur. Resmi ithal ettikten hemen sonra kırpmayı ya da yeniden örneklemeyi planlıyorsanız, bu seçeneği kullanarak bir kırpma ya da yeniden örnekleme iletişim kutusuna ulaşabi​lirsiniz. Kırpma ya da yeniden örneklemeyi ithal işleminin bir parçası olarak yapmak, resmi ithal ettikten sonra yapmaktan daha hızlıdır. [1,3].

14.3
Bir Dosyayı İhraç Etmek
İhraç işlemi de yine File menüsünden gerçekleştirilir. File menüsünde Export komutunu seçe​bilir ya da CTRL + E tuşlarına basabilirsiniz. Bu, ana Export iletişim kutusunu açar. Klasörler a-rasındaki gezinme aynen Import iletişim kutusunda olduğu gibi yapılır. Compression (sıkış​tırma) açılır listesi, eğer ihraç ettiğiniz dosya tipi iki ya da daha fazla sıkıştırma tipini destekli​yorsa, kullanılabilir hale gelir ve buradan, kullanmak istediğiniz sıkıştırma tipini seçebilirsiniz. Ayrıca aşağıdaki seçenekleri de kullanabilirsiniz [image: image83.wmf](Şekil 14.2).
Şekil 14.2 : Export İletişim Kutusu

•   Selected Only seçeneği ile sadece seçili nesneyi ihraç edebilirsiniz (Bütün çalışmanızı değil).
• Sonuçta bir Web sayfasında görüntülenecek olan bir dosyayı kaydediyorsanız, Web_Safe_Filenames seçeneğini işaretlemek isteyebilirsiniz. Bu, dosya adındaki tüm boşlukları (_) alt çizgi karakteriyle doldurur. Bu seçeneğe Web Uyumlu (Web Safe -Web Güvenli) denir, çünkü çoğu Web sunucusu dosya adındaki boşlukları destekleme​mektedir.
•    Do Not Show Filler Dialog seçeneği, dosyanızı ihraç ederken seçenekleri ayarlamanızı istemeden varsayılan ayarları kullanır. Bu, sadece birden çok ihraç seçeneğini destekle​yen dosya tiplerinde kullanılabilir [1,3].

16.4 Import ve Export Dosyaları


CorelDRAW 10 geniş Import/Export filtre seçim imkanlarına sahip prog​ramlardan biridir. Corel ürünleri tamamen desteklenmekte ve Corel PHOTO-PAINT, Corel PAIN-TER, Corel PRESENTATIONS ve Corel WORDPERFECT için filtreler bulunmaktadır. Adobe lllustrator, Photoshop ve Acrobat; Kodak FlashPix ve PhotoCD; Macromedia Flash; Microsoft Word; PostScript baskı dili ve Scitex tarama dili gibi diğer yazılım ve donanım üreticilerine ait olan dosya tipleri de ayrıca desteklenmektedir.
Bu formatlara ek olarak, CorelDRAW 10 ayrıca BMP (Windows ve OS/2), GIF (sabit ve hare​ketli), JPG, PNG, TGA ve TIFF bitmap formatları gibi standart grafik endüstrisi dosya formatlarını da desteklemektedir. Yine, CGM, EMF ve WMF gibi standart vektör dosya tipleri için filtreler bulunmakta ve RTF ve TXT gibi standart metin tipleri de desteklenmektedir [1].
15. UYGULAMA 

15.1 Broşür Çalışması

Amaç: Vakumlu Isı Sistemli Jeotermal Termoelektrik Jeneratör’ün özelliklerinin, Türkçe ve İngilizce olarak belirtilmesi ve ilgi çekici hale getirmek için, göze hitap edecek biçimde, orijinal resimleri ve metinleri CorelDRAW’ın tasarım özellikleriyle bir araya getirmek.

 Broşür hazırlamaya başlamadan önce, gerekli malzemeler elde edilmeli. Bu malzemeler Jeneratör’e ait değişik açılardan çekilmiş resimler ve özelliklerini belirten metinlerdir.

Tasarım yapmadan önce kafamızda tasarım şeklini belirlemeliyiz. Nasıl Bir kağıda tasarım yapılacak, tek taraflı mı yoksa çift taraflı mı olacak, ,CorelDRAW safasında ön yüz neresi , arka yüz neresi olacak (kağıt katlama şekline göre değişir) v.b belirlemeliyiz. Bu doğrultuda tasarıma başlayabiliriz.

Bu çalışmada, ön ve arka yüzü üçe ayrılmış birşekilde tek bir kağıt  kullanılacaktır. Bu kağıdın genişliği 46 cm ve yüksekliği 21 cm olacaktır. 

Hazırlayacağım broşür çalışmasında aşağıdaki adımlar uygulanır.

1. Sayfa ebadının ayarlanması için, Layout(Page Setup mönüsü ile Şekil 15.1’de görülen Size iletişim kutusu açılır.
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Şekil 15.1 : Page Size İletişim Kutusu

Bu pencere üzerinden ölçü birimi olarak centimeters seçilir. Width değer kutusuna 46, Height değer kutusuna 21 değerleri girilir. Sayfayı yatık konuma getirmek için Landscape onay kutusu işaretlenir. TAMAM tuşuna basılır.

[image: image85.wmf]Sayfa ayarlamasını Property araç çubuğundan da yapabiliriz (Şekil 15.2).

Şekil 15.2 : Property Araç Çubuğu

2. Bu büyük sayfayı üçe bölmek ve bu bölmeler üzerinde daha rahat çalışmak için kılavuz çizgilerini kullanırız. Sayfa üzerinde altı adet kılavuz çizgisi kullanılacaktır. İki adet  kılavuz çizgisi yatay olarak sayfanın alt ve üst sınırına, iki adet dikey olarak sol ve sağ sınırına, bir tanesi soldan 15.4 cm ileriye, sonuncusu da soldan 30,8 cm ileriye dikey olarak yerleştirilir. Yerleştirilen son iki kılavuz çizgisi kağıdı üçe bölmek için alınacak referans noktalarını belirleyecektir. Kılavuz çizgilerini dikey olarak eklemek için, sol taraftaki sayfa cetveli, çizim penceresine sürüklenir; yatay olarak eklemek için de üst taraftaki sayfa cetveli çizim penceresine sürüklenir. Kılavuz çizgilerinin yerini tam olarak belirlemek için, çizgi seçili Property çubuğu üzerindeki x ve y değer  kutucuklarına gerekli sayısal değerleri girmek yeterlidir. Kılavuz çizgilerini yerleştirdikten sonra hepsini birden seçip, Arrange(Lock Object komutu verilerek sayfaya sabitlenmesi sağlanır.  Klavuz çizgileri tasarımı rahat yapabilmemiz için bir sınır özelliği taşır. Çıktıda görünmez. Sayfa bu aşamada Şekil 15.3’deki gibi görünecektir.
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Şekil 15.3 : Klavuz Çizgileri
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Ben ön ve arka kapak kısmını tasarım içinm kullanmayı düşündüm. Bu nedenle ön ve arka sayfa için bir tasarım oluştururuz. Önce tasarımda kullanılacak resimler import edilir. Bunun için File->Import seçeneği seçilir ve ekrana Şekil 15.4’deki mönü gelir. Buradan istenilen dosyalr seçilir ve import edilir. 
Şekil 15.4 : Import Mönüsü

4. Bu resimler çalışma pencersinin dışında bir yerde durur. Çünkü önce bu resimleri nasıl bir şekilde dizayn edeceğimizi belirlemeliyiz. Ben tasarım olarak broşürün ön ve arka sayfalarını kapsayan bir elips düşündüm. Bu elipsin içine , import ettiğim resim adedi kadar elips çizerek , resimleri bu küçük elipslerin içine yerleştirdim. Elips çizmek için elips araç kutusuna tıklanır (Şekil 15.5) ve ekranda çizmek istediğimiz yere mouse yardımıyla çizilir.
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Şekil 15.5 : Elips Araç Kutusunun Seçilmesi

Ekrana çizilen elipsler Şekil 15.6’daki gibidir.
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Şekil 15.6 : Elips Çizilmiş Sayfa

5. Elipsleri çizdikten sonra resimlerimizi elipslerin içine yerleştiririz ve interactive blend tool ile (Şekil 15.7) gölge elipslerin içine gölge uygularız. 
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Şekil 15.7 : Interactive Blend Tool aracının Seçimi


Ana sayfadaki küçük elpsin üstüne Termoelektrik Jeneratör yazısını yazacağımız bir diktörgen çizeriz ve köşelerini ovalleştiririz. Bu şekilde ana tasarım kısmını bitirmiş olduk (Şekil 15.8).
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Şekil 15.8 : Ana Tasarım Şekli

6. Şimdi sayfanın tamamına tasarım uygulayacağız. Two Color Pattern Dolgu seçeneği ile sayfaya yatay çizgiler yerleştireceğiz. Bunun için Fill Tool araç kutusundan Pattern Fill daha sonrada Two Color Pattern’i seçeriz. Karşımıza Şekil 15.9’daki mönü gelir. 
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Şekil 15.9 : Two Color Pattern Mönüsü

Buradan yatay çizgileri seçerek sayfamıza uygularız. Tabi bu çizgilerin renklerini diğer elips’lerin renkleriyle uyumlu seçmemiz gerefir. Ben genel olarak kırmızının tonlarını kullandım.  Sayfaya çizgileri yerleştirdikten sonra cihazımızla alakalı olan logoyu ön ve arka sayfaya yerleştiririz. Ayrıca broşür yapım yeri ve yılını da ön sayfaya paragraf text olarak ekleriz. Sayfanın son hali Şekil 15.10 ‘daki gibidir.
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Şekil 15.10 : Çizgilerle Birlikte Tasarım Şekli

7. Broşürümüz ön ve arka sayfa tasrımları bitmiş oldu. Sırada sol taraftaki sayfa ile en başta belirttiğimiz ikinci sayfa. Şekil 15.10 ‘un boş olan sol kısmına yine genel tasarımımıza uygun olarak bir elips çizip bunun içine resim koyacağız, bu işlemi yukarıda anlattığım şekilde yapacağım. Ardından da resmi çizgilerin altına yerleştirip interactive transparency tool ile ışığını kısarız. Ardından jeneratörümüz hakkında elimde olan tablo verilerini bu sayfaya yazarım. Bu esnada da diktörtgen çizimi ile bir stil oluştururuz. Bilgilerimizi bu kutuların içine yazarız. Broşürün bu yüzünün tasarımı bu şekilde bitmiştir (Şekil 15.11).
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Şekil 15.11 : Broşürün İlk Sayfa Tasarımı

8. Sıra diğer sayfanın tasarımını yapmaya geldi.. Bu tasarım yapacağımız sayfa katlanınca iç tarafa geleceği için burası daha çok metin ağırlıklı görünecek. Metinlerin altına da transparan resimler konulacak. Öncelikle sayfanın tamamına diğer sayfada uyguladığımız two color pattern dolgusu ile yatay çizgi uygularız. Daha sonra her sayfaya köşeleri oval olan bir diktörtgen çizeriz ve bunun içini beyaza boyayıp transparan yaparız. Bu şekilde bir şeffaflık sağlamış oluruz. Oluşan bu tasarım Şekil 15.12’de gösterildiği gibidir.
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 Şekil 15.12 : Transparan Boş Sayfa

9. [image: image96.png]=t
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Daha sonra her sayafa elips çizerek içlerine jeneratörle ilgili resimlerden koyup, diğer sayfa da olduğu gibi bu resimleri de transparan yaparız (Şekil 15.13).

Şekil 15.13 : Transparan Resimli Boş Sayfa

10. Son olarak da tasarım yaptığımız Vakumlu Isı Sistemli Termoelektrik Jeneratör hakkında elimzde bulunan metinleri , sayfalara dikdörtgen çizerek bu dikdörtgenlerin içine yerleştiririz. Burada kullanacağımız dikdörtgenler diğer sayfada tablo için kullanmış olduğumuz dikdörtgenlerle aynı şekilde olmalı ki tasarımımızda bir bütünlük olsun.

Broşürün her iki sayfasının da tasarımı bitmiş görünümü Şekil 15.14’de görünmektedir.
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Şekil 15.14 : Broşürün Her İki Yüzü
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Tablo 2.1: Standart Araç Çubuğu Kısayol İkonları
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Şekil 2.4 : 
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Bu ekranı bir daha görmemek için tıklanır.





CorelDRAW ile ilgili  çevrimiçi kaynaklara erişmek için tıklanır.
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